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Mengenai Buku Ini
PERINGATAN! Teks yang ditampilkan dengan simbol ini menunjukkan bahwa jika petunjuk tidak
dijalankan, dapat mengakibatkan cedera tubuh atau kematian.

PERHATIAN: Teks yang ditampilkan dengan simbol ini menunjukkan bahwa pelanggaran atas
petunjuk yang diberikan dapat mengakibatkan kerusakan perangkat atau kehilangan informasi.

CATATAN: Teks yang ditampilkan seperti ini berisi informasi tambahan yang penting.
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1 Fitur-fitur Diagnostik Komputer

HP Insight Diagnostics
CATATAN: HP Insight Diagnostics tercakup di CD hanya pada model komputer tertentu.

Utilitas HP Insight Diagnostics memungkinkan Anda melihat informasi tentang konfigurasi perangkat
keras pada komputer dan menjalankan uji diagnostik perangkat keras pada subsistem komputer. Utilitas
ini akan memudahkan proses identifikasi, diagnosis, dan menemukan masalah perangkat keras secara
efektif.

Tab Survey akan ditampilkan saat Anda menjalankan HP Insight Diagnostics. Tab ini menunjukkan
konfigurasi komputer yang aktif saat ini. Dari tab Survey, Anda dapat mengakses beberapa kategori
informasi tentang komputer. Tab lainnya berisi informasi tambahan, termasuk pilihan uji diagnostik dan
hasil pengujian. Informasi pada setiap layar utilitas dapat disimpan sebagai file html dan disimpan di
disket atau USB HP Drive Key.

Gunakan HP Insight Diagnostics untuk memastikan semua perangkat yang terpasang pada komputer
dapat dikenali oleh sistem dan berfungsi dengan baik. Menjalankan pengujian adalah pilihan, namun
Anda disarankan untuk menjalankannya setelah memasang atau menghubungkan perangkat baru.

Anda harus menjalankan pengujian, menyimpan hasil pengujian, dan mencetaknya sehingga Anda
memiliki laporan tercetak sebelum menghubungi Customer Support Center.

CATATAN: Perangkat pihak ke tiga kemungkinan tidak terdeteksi oleh HP Insight Diagnostics.

Mengakses HP Insight Diagnostics
Untuk mengakses HP Insight Diagnostics, Anda harus memuat satu Set Disc Pemulihan, kemudian
boot CD yang berisi utilitas. IPM juga dapat di-download dari http://www.hp.com. Lihat Men-download
Versi Terbaru HP Insight Diagnostics pada hal. 5 untuk informasi lebih lanjut.

CATATAN: HP Insight Diagnostics hanya disertakan sebagai bagian dari Recovery Disk Set [Set Disk
Pemulihan] pada model komputer tertentu.

Jika sudah membuat Set Disc Pemulihan, mulai laksanakan prosedur berikut pada langkah 4.

1. Klik Start [Mulai] > HP Backup and Recovery [Pencadangan dan Pemulihan HP] > HP Backup
and Recovery Manager [Manajer Pencadangan dan Pemulihan HP] untuk membuka Backup and
Recovery Wizard [Wizard Pencadangan dan Pemulihan], lalu klik Next [Berikutnya].

2. Pilih Create a set of recovery discs (Recommended)[Buat set disc pemulihan
(Direkomendasi)] lalu klik Next [Berikutnya].

3. Ikuti petunjuk dalam Wizard untuk membuat Set Disc Pemulihan.

4. Gunakan Windows Explorer untuk mencari CD yang memuat direktori compaq\hpdiags pada
Recovery Disc Set [Set Disc Pemulihan].

5. Saat komputer dalam keadaan hidup, masukkan CD ke dalam drive optik pada komputer.
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6. Matikan sistem operasi, kemudian matikan komputer.

7. Hidupkan komputer. Sistem akan di-boot dari CD.

CATATAN: Jika sistem tidak mem-boot dari CD yang terdapat di drive optik, Anda harus
mengubah urutan boot pada utilitas Computer Setup (F10) agar sistem mencoba boot ke drive
optik sebelum booting ke hard drive. Lihat Panduan Utilitas Pengaturan Komputer (F10) untuk
informasi lebih lanjut.

8. Pilih bahasa yang sesuai, kemudian klik Continue.

CATATAN: Disarankan agar Anda menentukan papan ketik default untuk bahasa Anda kecuali
Anda ingin menguji papan ketik tertentu.

9. Pada halaman End User License Agreement, klik Agree untuk menyetujui persyaratan yang
diberikan. Utilitas HP Insight Diagnostics akan dijalankan dengan tombol Survey dalam keadaan
ditampilkan.

Tab Survey
Tab Survey menampilkan informasi penting tentang konfigurasi sistem.

Di kolom View level, Anda dapat memilih tampilan Summary untuk melihat data konfigurasi tertentu
atau memilih tampilan Advanced untuk melihat semua data dalam kategori yang dipilih.

Di kolom Category, Anda dapat memilih kategori informasi berikut ini untuk ditampilkan:

All—Memberikan daftar semua kategori informasi tentang komputer.

Overview—Memberikan daftar informasi umum tentang komputer.

Architecture—Memberikan informasi perangkat BIOS sistem dan PCI.

Asset Control—Menunjukkan nama produk, label aset, nomor seri sistem, dan informasi prosesor.

Communication—Menunjukkan informasi tentang pengaturan port paralel (LPT) dan serial (COM)
komputer, plus informasi tentang kontroler USB dan jaringan.

Graphics—Menunjukkan informasi tentang kontroler gambar pada komputer.

Input Devices—Menunjukkan informasi tentang papan ketik, mouse, dan perangkat lainnya yang
terhubung ke komputer.

Memory—Menunjukkan informasi tentang memori pada komputer. Ini termasuk slot memori pada
system board dan modul memori lainnya yang terpasang.

Miscellaneous—Menunjukkan informasi versi HP Insight Diagnostics, informasi memori konfigurasi
komputer (CMOS), data system board, dan data BIOS manajemen sistem.

Storage—Menunjukkan informasi tentang media penyimpanan pada komputer. Daftar ini meliputi
semua disk permanen, drive disket, dan drive optik.

System—Menunjukkan informasi tentang model komputer, prosesor, rangka, dan BIOS, plus speaker
internal dan informasi bus PCI.
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Tab Test
Tab Test memungkinkan Anda memilih berbagai komponen sistem untuk diuji. Anda juga dapat memilih
jenis dan mode pengujian.

Terdapat tiga jenis pengujian yang dapat dipilih, yaitu:

● Quick Test—Menyediakan skrip untuk digunakan oleh masing-masing komponen perangkat
keras tidak diperlukan intervensi baik dalam Unattended mode atau Interactive mode.

● Complete Test—Menyediakan skrip untuk digunakan oleh masing-masing komponen perangkat
keras yang akan diuji penuh. Interactive mode memiliki lebih banyak pengujian, namun diperlukan
intervensi pengguna.

● Custom Test—Memberikan fleksibilitas paling baik dalam mengontrol pengujian sistem. Custom
Test mode memungkinkan Anda secara spesifik memilih jenis perangkat, pengujian, dan
parameter pengujian yang dijalankan.

Untuk setiap jenis pengujian, ada dua mode pengujian yang dapat dipilih:

● Interactive Mode—Memberikan kontrol maksimum melalui proses pengujian. Dalam Interactive
Mode, perangkat lunak diagnostik akan meminta masukan selama pengujian jika interaksi Anda
diperlukan. Anda juga dapat menentukan apakan pengujian lulus atau gagal.

● Unattended Mode—Tidak menampilkan perintah dan tidak memerlukan interaksi. Jika ditemukan
kesalahan (error), maka kesalahan tersebut akan ditampilkan setelah pengujian selesai.

Untuk memulai pengujian:

1. Pilih tab Test.

2. Pilih tab untuk jenis pengujian yang akan dijalankan: Quick (Cepat), Complete (Lengkap), atau
Custom (Tersesuai).

3. Pilih Test Mode: Interactive (Interaktif) atau Unattended (Tanpa Ditunggu).

4. Pilih cara yang Anda inginkan untuk menjalankan pengujian, antara Number of Loops atau Total
Test Time. Jika Anda memilih untuk menjalankan pengujian berdasarkan jumlah loop tertentu,
masukkan jumlah loop yang akan dijalankan. Jika Anda ingin melakukan uji diagnostik selama
rentang waktu tertentu, masukkan jumlah waktu yang diinginkan dalam menit.

5. Jika menjalankan Quick Test atau Complete Test, pilih drive yang akan diuji dari daftar buka bawah.
Jika menjalankan Custom Test, klik tombol Expand lalu pilih perangkat yang akan diuji atau klik
tombol Check All untuk memilih semua perangkat.

6. Klik tombol Begin Testing di sudut kanan bawah layar untuk memulai pengujian. Tab Status, yang
dapat Anda gunakan untuk memantau progres pengujian, secara otomatis akan ditampilkan
selama proses pengujian. Setelah pengujian selesai, tab Status akan menunjukkan apakah
perangkat mengalami kegagalan atau berhasil.

7. Jika terjadi kesalahan, buka tab Log lalu klik Error Log untuk menampilkan informasi lebih lanjut
dan tindakan yang disarankan.

Tab Status
Tab Status berfungsi menampilkan status pengujian yang dipilih. Jenis pengujian yang dijalankan
(Quick, Complete, atau Custom) juga ditampilkan. Bilah progres utama akan menampilkan persentase
penyelesaian rangkaian pengujian. Ketika pengujian berlangsung, tombol Cancel Testing akan
ditampilkan untuk digunakan jika Anda akan membatalkan pengujian.

Setelah pengujian selesai, tombol Cancel Testing diganti dengan tombol Retest. Tombol Retest
berfungsi untuk menguji ulang rangkaian pengujian yang terakhir dijalankan. Ini memungkinkan Anda
menjalankan kembali rangkaian pengujian tanpa harus memasukkan lagi data ke dalam tab Test.
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Tab Status juga menunjukkan:

● Perangkat yang sedang diuji

● Status pengujian (berlangsung, lulus, atau gagal) dari setiap perangkat yang diuji

● Status kemajuan seluruh pengujian dari semua perangkat yang diuji

● Status kemajuan dari setiap perangkat yang diuji

● Waktu pengujian yang telah berlalu dari setiap perangkat yang diuji

Tab Log
Tab Log berisi tab Test Log dan tab Error Log.

Test Log menampilkan semua pengujian yang telah dijalankan, berapa kali pengujian dijalankan,
berapa kali pengujian tersebut gagal, dan waktu yang diperlukan untuk menyelesaikan masing-masing
pengujian. Tombol Clear Test Log akan menghapus isi Test Log.

Error Log menampilkan pengujian untuk perangkat yang gagal sewaktu pengujian diagnostik dan
menyertakan kolom informasi berikut ini.

● Bagian Device menampilkan perangkat yang diuji.

● Bagian Test menampilkan jenis pengujian yang dijalankan.

● Bagian Description menjelaskan kesalahan yang ditemukan dalam uji diagnostik.

● Recommended Repair akan memberikan saran tindakan yang harus dilakukan untuk mengatasi
masalah perangkat keras yang gagal tersebut.

● Failed Count adalah nilai yang menyatakan berapa kali perangkat gagal dalam pengujian.

● Error Code menampilkan kode numerik untuk setiap kegagalan. Error codes atau kode kesalahan
didefinisikan dalam tab Help.

Tombol Clear Error Log akan menghapus isi Error Log.

Tombol Help
Tab Help berisi tab HP Insight Diagnostics, tab Error Codes, dan tab Test Components.

Tab HP Insight Diagnostics berisi topic bantuan dan termasuk fitur pencarian dan indeks.

Tab Error Codes memberikan penjelasan untuk masing-masing kesalahan kode numerik yang
mungkin muncul dalam tab Error Log yang ada pada tab Log. Setiap kode terkait dengan Message
kesalahan tertentu dan tindakan Recommended Repair untuk membantu mengatasinya. Untuk
menemukan penjelasan kode kesalahan dengan cepat, masukkan kode ke kotak di bagian atas tab
tersebut lalu klik tombol Find Error Codes.

Tab Test Components memperlihatkan informasi level rendah dari pengujian yang dijalankan.

Menyimpan dan Mencetak Informasi dalam HP Insight Diagnostics
Anda dapat menyimpan informasi yang ditampilkan pada tab Survey dan Log HP Insight Diagnostics
ke disket atau ke USB 2.0 HP Drive Key (64MB atau lebih tinggi). Anda tidak dapat menyimpannya ke
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hard drive. Sistem secara otomatis akan membuat file html dengan penampilan yang sama dengan
informasi yang terlihat di layar.

1. Masukkan disket atau USB 2.0 HP Drive Key (kapasitasnya harus 64MB atau lebih). USB 1.0 Drive
Keys tidak didukung.

2. Klik Save di sudut kanan bawah layar.

3. Pilih Save to the floppy atau Save to USB key.

4. Masukkan nama file ke kotak File Name lalu klik tombol Save. File html akan disimpan ke disket
atau USB HP Drive Key.

CATATAN: Jangan keluarkan disket atau USB key sebelum Anda melihat pesan yang
menunjukkan bahwa file html telah ditulis ke media tersebut.

5. Cetak informasi tersebut dari perangkat penyimpanan yang digunakan untuk menyimpannya.

CATATAN: Untuk keluar dari HP Insight Diagnostics, klik tombol Exit Diagnostics di sudut kiri bawah
layar kemudian keluarkan CD dari drive optik.

Men-download Versi Terbaru HP Insight Diagnostics
1. Kunjungi http://www.hp.com.

2. Klik link Software & Driver Downloads.

3. Masukkan nomor produk (misalnya, dc7800) ke kotak teks, lalu tekan tombol Enter.

4. Pilih model komputer Anda.

5. Pilih OS Anda.

6. Klik link Diagnostic.

7. Klik HP Insight Diagnostics Offline Edition.

8. Pilih salah satu bahasa lalu klik Download.

CATATAN: File hasil download tersebut juga berisi petunjuk tentang cara membuat CD boot.

Melindungi Perangkat Lunak
Untuk melindungi perangkat lunak dari kehilangan atau kerusakan, Anda harus menyimpan salinan
cadangan dari semua perangkat lunak sistem, aplikasi, dan file terkait yang tersimpan pada hard drive.
Lihat dokumentasi sistem operasi atau utilitas pembuat cadangan (backup utility) untuk petunjuk
mengenai cara membuat salinan cadangan file data.

HP Backup and Recovery Manager
HP Backup and Recovery Manager adalah aplikasi serba guna, mudah digunakan yang memungkinkan
Anda untuk membuat cadangan dan memulihkan hard drive primer pada PC. Aplikasi ini bekerja dalam
Windows untuk membuat cadangan Windows, semua aplikasi dan semua file data. Salinan cadangan
dapat dijadwalkan secara otomatis pada interval tertentu, atau dijalankan secara manual. File penting
dapat diarsipkan secara terpisah dari cadangan reguler.
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HP Backup and Recovery Manager sudah diinstal pada Partisi Pemulihan hard drive dan
memungkinkan Anda untuk:

● membuat Recovery Point untuk membuat salinan cadangan seluruh sistem secara bertahap

● membuat salinan cadangan seluruh sistem dalam satu arsip

● membuat salinan cadangan masing-masing file dan folder

Titik Pemulihan dan cadangan file dapat disalin ke CD atau disc DVD, sedangkan semua cadangan
dapat disalin ke jaringan atau hard disk sekunder.

HP sangat menganjurkan Anda untuk segera membuat Recovery Disc Set sebelum menggunakan
komputer dan menjadwalkan pembuatan salinan cadangan Recovery Point otomatis secara rutin.

Untuk membuat Set CD Pemulihan:

1. Klik Start > HP Backup and Recovery > HP Backup and Recovery Manager untuk membuka
Backup and Recovery Wizard, lalu klik Next.

2. Pilih Create a set of recovery discs (Recommended)[Buat set disc pemulihan
(Direkomendasi)] lalu klik Next [Berikutnya].

3. Ikuti petunjuk pada wizard.

HP Backup and Recovery Manager menyediakan dua metode pemulihan dasar. Pertama, pemulihan
file dan folder, beroperasi dalam Windows. Kedua, PC Recovery, memerlukan boot ulang ke Recovery
Partition atau dari Recovery Disc Set. Untuk mem-boot ulang ke Recovery Partition, tekan F11 saat
dihidupkan ketika Anda melihat pesan "Press F11 for Emergency Recovery".

Untuk informasi lebih lanjut tentang menggunakan HP Backup and Recovery Manager, lihat HP Backup
and Recovery Manager User Guide dengan memilih Start > HP Backup and Recovery > HP Backup
and Recovery Manager Manual.

CATATAN: Anda dapat memesan Set CD Pemulihan dari HP dengan menghubungi pusat dukungan
HP. Kunjungi situs Web berikut, pilih wilayah Anda, lalu klik link Technical support after you buy di
bawah judul Call HP untuk memperoleh nomor telepon pusat dukungan untuk wilayah Anda.

http://welcome.hp.com/country/us/en/wwcontact_us.html
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2 Mengatasi Masalah Tanpa Diagnostik

Bab ini berisi informasi mengenai cara mengenali dan memperbaiki masalah kecil, seperti masalah drive
disket, hard drive, drive optik, gambar, audio, memori, dan perangkat lunak. Jika Anda mengalami
masalah pada komputer, lihat tabel dalam bab ini untuk mengetahui penyebab yang mungkin serta
solusi yang disarankan.

CATATAN: Untuk informasi tentang pesan kesalahan tertentu yang mungkin muncul di layar selama
Power-On Self-Test (POST) saat dihidupkan, lihat Lampiran A, Pesan Kesalahan POST
pada hal. 50.

Keselamatan dan Kenyamanan
PERINGATAN! Kesalahan penggunaan komputer atau kegagalan menciptakan lingkungan kerja
yang aman dan nyaman akan mengakibatkan ketidaknyamanan atau cedera serius. Lihat Panduan
Keselamatan & Kenyamanan di http://www.hp.com/ergo untuk informasi lebih lanjut tentang cara
memilih ruang kerja dan menciptakan lingkungan kerja yang aman dan nyaman. Perlengkapan ini sudah
diuji dan ternyata memenuhi batas-batas untuk perangkat digital Kelas B, sesuai dengan Bagian 15 dari
Peraturan FCC. Untuk informasi lebih lanjut, rujuk ke Panduan Informasi Keselamatan & Pengaturan.

Sebelum Menghubungi Dukungan Teknis
Jika Anda mengalami masalah dengan komputer, cobalah solusi yang sesuai di bawah ini untuk
menemukan masalah yang sebenarnya sebelum menelpon dukungan teknis.

● Jalankan utilitas diagnostik. Lihat Bab 1, Fitur-fitur Diagnostik Komputer pada hal. 1 untuk informasi
lebih lanjut.

● Jalankan Drive Protection System (DPS) Self-Test dalam Computer Setup. Lihat Panduan Utilitas
Pengaturan Komputer (F10) untuk informasi lebih lanjut.

● Periksa LED daya di bagian depan komputer untuk melihat apakah berkedip merah. Lampu yang
berkedip adalah kode kesalahan yang akan membantu Anda mendiagnosa masalah tersebut. Lihat
Lampiran A, Pesan Kesalahan POST pada hal. 50 untuk informasi lebih lanjut.

● Jika layar kosong, hubungkan monitor ke port video lain pada komputer jika tersedia. Atau, ganti
monitor dengan monitor lain yang Anda ketahui berfungsi dengan baik.

● Jika Anda bekerja pada jaringan, hubungkan komputer lain dengan kabel yang berbeda ke koneksi
jaringan. Mungkin ada masalah dengan plug atau kabel jaringan.

● Jika Anda baru saja menambahkan perangkat keras baru, lepaskan perangkat keras tersebut dan
lihat apakah komputer berfungsi dengan baik.

● Jika Anda baru saja menginstal perangkat lunak baru, hapus instalasi perangkat lunak tersebut
dan lihat apakah komputer berfungsi dengan baik.

● Boot komputer ke Safe Mode untuk melihat apakah komputer dapat dihidupkan tanpa memuat
semua driver. Ketika mem-boot sistem operasi, gunakan "Last Known Configuration".
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● Lihat dukungan teknis komprehensif online di http://www.hp.com/support.

● Lihat bagian Saran Praktis pada hal. 8 berikut dalam panduan ini.

Untuk mendampingi Anda dalam mengatasi masalah secara online, HP Instant Support Professional
Edition membekali Anda dengan diagnostik pemecahan sendiri. Jika Anda perlu menghubungi
dukungan HP, gunakan fitur chat online HP Instant Support Professional Edition. HP Instant Support
Professional Edition dapat diakses pada: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) di http://www.hp.com/go/bizsupport untuk informasi
dukungan online, perangkat lunak dan driver terbaru, pemberitahuan proaktif, dan komunitas sesama
pengguna dan pakar HP di seluruh dunia.

Jika Anda perlu meminta bantuan teknis, siapkan informasi berikut ini untuk melancarkan panggilan
servis Anda:

● Buat panggilan telepon di depan komputer Anda.

● Catat nomor seri dan nomor ID produk komputer, dan nomor seri monitor Anda sebelum menelpon.

● Luangkan waktu untuk mengatasi masalah tersebut dengan teknisi servis.

● Lepaskan semua perangkat keras yang baru saja ditambahkan ke sistem Anda.

● Hapus instalasi semua perangkat lunak yang baru saja diinstal.

● Pulihkan sistem dari Recovery Disc Set (Set Disc Pemulihan) yang sudah Anda buat atau,
kembalikan sistem ke kondisi pabrik semula dengan menggunakan HP Backup and Recovery
Manager (Pengelola Pemulihan dan Pencadangan HP).

PERHATIAN: Pemulihan sistem akan menghapus semua data pada hard drive. Pastikan Anda
membuat cadangan semua file data sebelum menjalankan proses pemulihan.

CATATAN: Untuk informasi tentang penjualan dan peningkatan cakupan garansi (Care Pack),
hubungi penyedia layanan atau dealer resmi Anda.

Saran Praktis
Jika Anda mengalami masalah dengan komputer, monitor, atau perangkat lunak, lihat daftar saran
umum berikut ini sebelum mengambil tindakan selanjutnya:

● Periksa apakah komputer dan monitor terhubung ke stopkontak listrik yang berfungsi.

● Periksa apakah switch pengatur tegangan (pada model tertentu) sudah diatur ke tegangan yang
sesuai untuk negara/kawasan Anda (115V atau 230V).

● Periksa apakah komputer dihidupkan dan lampu daya hijau menyala.

● Periksa apakah monitor dihidupkan dan lampu monitor hijau menyala.

● Periksa LED daya di bagian depan komputer untuk melihat apakah berkedip merah. Lampu yang
berkedip adalah kode kesalahan yang akan membantu Anda mendiagnosa masalah. Lihat
Lampiran A, Pesan Kesalahan POST pada hal. 50 untuk informasi lebih lanjut.

● Naikkan kontrol kecerahan dan kontras monitor jika monitor redup.

● Tekan dan tahan tombol apa saja. Jika sistem mengeluarkan bunyi bip, berarti keyboard berfungsi
dengan benar.

● Periksa semua kabel apakah ada sambungan yang kendor atau salah.

● Bangunkan komputer dengan menekan tombol apa saja pada keyboard atau menekan tombol
daya. Jika sistem tetap berada pada mode suspend (ditangguhkan), matikan komputer dengan

8 Bab 2   Mengatasi Masalah Tanpa Diagnostik IDWW

http://www.hp.com/support
http://www.hp.com/go/ispe
http://www.hp.com/go/bizsupport


menekan terus tombol daya minimal selama 4 detik, kemudian tekan kembali tombol daya untuk
menghidupkan ulang komputer. Jika sistem tidak mau dimatikan (shut down), lepaskan kabel daya,
tunggu beberapa detik, kemudian pasang kembali kabel. Komputer akan dihidupkan ulang jika
mulai otomatis setelah daya terputus diatur pada Computer Setup. Jika tidak dihidupkan ulang,
tekan tombol daya untuk menghidupkan komputer.

● Konfigurasikan ulang komputer setelah memasang papan ekspansi atau perangkat tambahan lain
yang non-plug and play. Untuk petunjuk, lihat Mengatasi Masalah Pemasangan Perangkat Keras
pada hal. 33.

● Pastikan semua driver perangkat yang diperlukan telah diinstal. Misalnya, jika Anda menggunakan
printer, Anda memerlukan driver untuk model printer tersebut.

● Lepaskan semua media yang dapat di-boot (disket, CD, atau perangkat USB) dari sistem sebelum
dihidupkan.

● Jika Anda menginstal sistem operasi selain yang diinstal pada pengaturan pabrik, periksa untuk
memastikan sistem operasi tersebut didukung pada sistem.

● Jika sistem memiliki beberapa sumber video (adapter tertanam, PCI, atau PCI-Express) terpasang
(video tertanam pada model tertentu) dan monitor tunggal, monitor tersebut harus dihubungkan
ke konektor monitor pada sumber yang dipilih sebagai adapter VGA primer. Saat booting, konektor
monitor lainnya dinonaktifkan dan jika monitor terhubung ke port ini, monitor tidak akan berfungsi.
Anda dapat memilih sumber mana yang akan menjadi sumber VGA default pada Computer Setup.

PERHATIAN: Bila komputer terhubung ke catu daya AC, selalu ada tegangan pada system board.
Anda harus melepaskan kabel daya dari catu daya sebelum membuka komputer untuk mencegah
kerusakan system board atau komponen komputer.
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Mengatasi Masalah Umum
Anda mungkin dapat dengan mudah mengatasi masalah umum yang diuraikan dalam bagian ini. Jika
masalah tetap berlanjut dan Anda tidak dapat mengatasinya sendiri atau jika Anda tidak ingin melakukan
perbaikan sendiri, hubungi penyedia atau agen resmi.

PERINGATAN! Bila komputer dihubungkan ke stopkontak listrik AC, selalu ada tegangan pada
system board. Untuk mengurangi risiko cedera dari sengatan listrik dan/atau permukaan panas,
pastikan untuk melepaskan kabel daya dari dtopkontak di dinding dan biarkan komponen sistem internal
mendingin sebelum menyentuhnya.

Tabel 2-1  Mengatasi Masalah Umum

Komputer seperti terkunci dan tidak dapat dimatikan saat tombol daya ditekan.

Penyebab Solusi

Pengontrolan perangkat lunak terhadap saklar daya tidak
berfungsi.

1. Tekan terus tombol daya selama sedikitnya empat detik
sampai komputer mati.

2. Lepaskan kabel daya dari stopkontak.

Komputer tidak bereaksi terhadap papan ketik atau mouse USB.

Penyebab Solusi

Komputer berada dalam mode standby (siaga). Tekan tombol daya atau tekan tombol apa saja untuk keluar
dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Sistem terkunci. Hidupkan ulang komputer.

Tanggal dan waktu komputer salah.

Penyebab Solusi

Baterai RTC (real-time clock) mungkin perlu diganti.

CATATAN: Menghubungkan komputer ke stopkontak AC
yang berfungsi baik akan memperpanjang masa pakai baterai
RTC.

Terlebih dahulu, setel ulang tanggal dan waktu pada Control
Panel (Computer Setup juga dapat digunakan untuk
menyesuaikan tanggal dan waktu RTC). Jika masalah tetap
berlanjut, ganti baterai RTC. Lihat Panduan Referensi
Perangkat Keras untuk petunjuk cara memasang baterai baru,
atau hubungi penyalur atau penjual resmi untuk minta bantuan
mengganti baterai RTC.

Kursor tidak dapat digerakkan dengan menggunakan tombol arrow pada papan tombol.

Penyebab Solusi

Tombol Num Lock mungkin aktif. Tekan tombol Num Lock. Lampu NumLock tidak boleh
menyala jika Anda ingin menggunakan tombol arrow. Tombol
Num Lock dapat dilumpuhkan (atau difungsikan) dalam
Computer Setup.
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Tidak ada suara atau volume suara terlalu rendah.

Penyebab Solusi

Volume sistem mungkin diatur rendah atau bisu. 1. Periksa setelan F10 BIOS untuk memastikan speaker
sistem internal tidak disetel ke bisu (setelan ini tidak
mempengaruhi speaker eksternal).

2. Pastikan speaker eksternal terhubung dengan baik dan
dihidupkan dan kontrol volume speaker disetel dengan
benar.

3. Gunakan kontrol volume sistem yang tersedia pada
sistem operasi untuk memastikan speaker tidak disetel
ke bisu atau untuk menaikkan volume.

Tidak dapat melepaskan penutup komputer atau panel akses komputer.

Penyebab Solusi

Fitur Smart Cover Lock, yang terdapat pada komputer tertentu,
dikunci.

Bukalah Smart Cover Lock dengan menggunakan Computer
Setup.

Smart Cover FailSafe Key adalah perangkat yang digunakan
untuk menonaktifkan Smart Cover Lock, yang dapat diperoleh
dari HP. FailSafe Key ini diperlukan jika ada sandi yang lupa,
listrik mati, atau kerusakan komputer. Pesanlah PN
166527-001 untuk kunci jenis kunci pas (wrench) atau PN
166527-002 untuk kunci jenis mata obeng (screwdriver bit).

Kinerja komputer buruk.

Penyebab Solusi

Prosesor panas. 1. Pastikan aliran udara ke komputer tidak terhalang.
Sediakan jarak ruang 10,2 cm (4 inci) pada semua sisi
komputer yang dilengkapi bukaan ventilasi serta di atas
monitor agar udara dapat mengalir.

2. Pastikan kipas terhubung dan berfungsi dengan baik
(kipas tertentu hanya beroperasi jika diperlukan).

3. Pastikan alat pendingin (heatsink) prosesor dipasang
dengan benar.

Hard drive penuh. Pindahkan data dari hard drive untuk menyediakan lebih
banyak ruang pada hard drive.

Memori kurang. Tambahkan memori.

Hard drive terfragmentasi. Lakukan defragmentasi hard drive.

Program yang sebelumnya diakses tidak mengembalikan
memori ke sistem.

Hidupkan ulang komputer.

Ada virus yang berdiam pada hard drive. Jalankan program anti virus.

Aplikasi yang dijalankan terlalu banyak. 1. Tutup aplikasi yang tidak diperlukan untuk
membebaskan memori.

2. Tambahkan memori. Beberapa aplikasi bekerja di latar
belakang dan dapat ditutup dengan mengklik kanan ikon
yang terkait pada panel tugas. Untuk mencegah aplikasi
ini dijalankan saat startup, buka Start [Mulai] > Run
[Jalankan] (Windows XP) atau Start [Mulai] >
Accessories [Aksesori] > Run [Jalankan] (Windows

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Kinerja komputer buruk.

Penyebab Solusi

Vista) lalu ketik msconfig. Pada tab Startup System
Configuration Utility (Utilitas Konfigurasi Sistem), hapus
tanda centang aplikasi yang tidak dikehendaki untuk
dijalankan secara otomatis.

Beberapa jenis aplikasi perangkat lunak, terutama game,
membebani subsistem grafis

1. Turunkan resolusi layar untuk aplikasi yang aktif atau lihat
dokumentasi yang menyertai aplikasi untuk mengetahui
cara meningkatkan performa dengan mengatur
parameter aplikasi tersebut.

2. Tambahkan memori.

3. Tingkatkan solusi gambar.

Penyebab tidak diketahui. Hidupkan ulang komputer.

Komputer mati secara otomatis dan LED Daya menyala Merah dua kali, sekali setiap detik, diikuti jeda dua detik, dan
komputer berbunyi bip dua kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala).

Penyebab Solusi

Perlindungan panas prosesor diaktifkan:

Ada kipas yang mungkin terhalang atau tidak berputar.

ATAU

Alat pendingin (heatsink) tidak terhubung dengan benar ke
prosesor.

1. Pastikan ventilasi udara komputer tidak terhalang dan
kipas pendingin prosesor berfungsi baik.

2. Buka penutup atas, tekan tombol daya, dan lihat apakah
kipas prosesor berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas terhubung ke kepala
system board.

3. Jika kipas sudah terpasang, tetapi tidak berputar, ganti
rakitan heatsink/kipas.

4. Hubungi agen atau penyedia layanan resmi.

Sistem tidak dapat dihidupkan dan LED di bagian depan komputer tidak menyala.

Penyebab Solusi

Sistem tidak dapat dihidupkan. Tekan terus tombol daya selama kurang dari 4 detik. Jika LED
hard drive berubah hijau, maka:

1. Periksa apakah switch pengatur tegangan, yang terletak
di bagian belakang catu daya pada model tertentu, sudah
diatur ke tegangan yang benar. Setelan tegangan yang
benar tergantung pada negara/kawasan Anda.

2. Lepaskan kartu ekspansi satu per satu hingga lampu
5V_aux pada system board menyala.

3. Gantilah system board.

ATAU

Tekan terus tombol daya selama kurang dari 4 detik. Jika LED
hard drive tidak berubah hijau, maka:

1. Periksa apakah unit komputer dihubungkan ke
stopkontak AC yang berfungsi baik.

2. Buka penutup atas dan periksa apakah kabel-kabel
tombol daya sudah terpasang dengan benar ke system
board.

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Sistem tidak dapat dihidupkan dan LED di bagian depan komputer tidak menyala.

Penyebab Solusi

3. Periksa apakah kedua kabel catu daya terhubung
dengan benar ke system board.

4. Periksa apakah lampu 5V_aux pada system board
menyala. Jika menyala, maka gantilah rangkaian kabel
tombol daya.

5. Jika lampu 5V_aux pada papan sistem tidak menyala,
ganti catu daya.

6. Gantilah system board.

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Mengatasi Masalah Daya
Penyebab dan solusi umum untuk masalah daya tercantum dalam tabel berikut ini.

Tabel 2-2  Mengatasi Masalah Daya

Aliran daya listrik terputus-putus.

Penyebab Solusi

Switch pengatur tegangan di bagian belakang rangka
komputer (pada model tertentu) tidak diatur ke tegangan yang
sesuai (115V atau 230V).

Pilih tegangan AC yang sesuai dengan menggunakan switch
pengatur tegangan.

Catu daya tidak dapat dihidupkan karena ada kesalahan catu
daya internal.

Hubungi penyedia layanan resmi untuk mengganti catu daya.

Komputer mati secara otomatis dan LED Daya menyala Merah dua kali, sekali setiap detik, diikuti jeda dua detik, dan
komputer berbunyi bip dua kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Perlindungan panas prosesor diaktifkan:

Ada kipas yang mungkin terhalang atau tidak berputar.

ATAU

Alat pendingin (heatsink) tidak terhubung dengan benar ke
prosesor.

1. Pastikan ventilasi udara komputer tidak terhalang dan
kipas pendingin prosesor berfungsi baik.

2. Buka penutup atas, tekan tombol daya, dan lihat apakah
kipas prosesor berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas terhubung ke kepala
system board.

3. Jika kipas sudah terpasang, tetapi tidak berputar, ganti
rakitan heatsink/kipas.

4. Hubungi agen atau penyedia layanan resmi.

LED daya berkedip Merah empat kali, setiap detik sekali diselingi jeda dua detik, dan terdengar bunyi bip empat kali.
(Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Gangguan daya (catu daya kelebihan beban). 1. Periksa apakah switch pengatur tegangan, yang terletak
di bagian belakang catu daya (model tertentu), sudah
diatur ke tegangan yang benar. Setelan tegangan yang
benar tergantung pada negara/kawasan Anda.

2. Buka penutup atas dan pastikan kabel catu daya 4atau
6-kawat sudah terpasang pada konektor di papan sistem.

3. Periksa apakah ada perangkat yang menyebabkan
masalah tersebut, yakni dengan melepaskan SEMUA
perangkat yang terpasang (seperti hard drive, drive
disket, atau drive optik, serta kartu ekspansi). Hidupkan
sistem. Jika sistem memasuki POST, maka matikan
komputer dan pasang kembali perangkat satu per satu,
kemudian ulangi prosedur di atas sampai gangguan
muncul. Ganti perangkat yang menyebabkan gangguan
tersebut. Lanjutkan dengan memasang perangkat satu
per satu untuk memastikan semua perangkat berfungsi
dengan benar.

4. Ganti catu daya.

5. Gantilah system board.

Adaptor catu daya eksternal yang salah ternyata digunakan
pada USDT.

Adaptor catu daya USDT harus 135W dan menggunakan
teknologi ID Smart sebelum sistem akan dialiri daya. Gantilah
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LED daya berkedip Merah empat kali, setiap detik sekali diselingi jeda dua detik, dan terdengar bunyi bip empat kali.
(Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

adaptor catu daya dengan adaptor catu daya USDT yang
disediakan oleh HP.

Tabel 2-2  Mengatasi Masalah Daya (Lanjutan)
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Mengatasi Masalah Disket
Penyebab dan solusi umum untuk masalah disket tercantum dalam tabel berikut ini.

CATATAN: Anda mungkin perlu mengkonfigurasi ulang komputer setelah menambah atau
melepaskan perangkat keras, misalnya drive disket tambahan. Untuk petunjuk, lihat Mengatasi Masalah
Pemasangan Perangkat Keras pada hal. 33.

Tabel 2-3  Mengatasi Masalah Disket

Lampu drive disket terus menyala.

Penyebab Solusi

Disket rusak. Pada Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties > Tools. Pada
Error-checking klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties [Properti] lalu pilih tab Tools [Alat Bantu]. Pada
Error-checking klik Check Now.

Disket dimasukkan secara tidak benar. Keluarkan disket, kemudian masukkan lagi.

Kabel drive tidak terpasang dengan benar. Ulangi penyambungan kabel drive. Pastikan keempat pin pada
kabel daya disket terhubung ke drive.

Drive tidak ditemukan.

Penyebab Solusi

Kabel longgar. Ulangi pemasangan kabel data dan kabel daya drive disket.

Drive lepas tidak tersambung dengan benar. Ulangi penyambungan drive.

Perangkat sudah disembunykkan dalam Computer Setup. Jalankan utilitas Computer Setup dan pastikan Device
Available [Perangkat Tersedia] dipilih untuk Legacy
Diskette [Disket Turunan] di Security [Keamanan] > Device
Security [Keamanan Perangkat].

Drive disket tidak dapat menulis pada disket.

Penyebab Solusi

Disket belum diformat. Format disket.

1. Dari Windows Explorer, pilih drive disket (A).

2. Klik kanan huruf drive, lalu pilih Format.

3. Pilih pilihan yang dikehendaki, kemudian klik Start untuk
mulai memformat disket.

Disket terproteksi penulisan. Gunakan disket lain, atau buka proteksi penulisan.

Menulis ke drive yang salah. Periksa huruf drive pada informasi jalur (path).

Kapasitas disket tidak mencukupi. 1. Gunakan disket lain.

2. Hapus file yang tidak diperlukan dari disket.

Fitur penulisan pada disket model lama (legacy) dinonaktifkan
pada Computer Setup.

Buka Computer Setup lalu aktifkan Legacy Diskette Write in
Storage > Storage Options.

Disket rusak. Ganti disket yang rusak.

16 Bab 2   Mengatasi Masalah Tanpa Diagnostik IDWW



Disket tidak dapat diformat.

Penyebab Solusi

Media tidak valid. Untuk memformat disk dalam MS-DOS, Anda mungkin harus
menuliskan kapasitas disket. Misalnya, untuk memformat
disket berkapasitas 1,44 MB, ketikkan perintah berikut pada
prompt MS-DOS:

FORMAT A: /F:1440

Disket terproteksi penulisan. Buka pengunci pada disket.

Fitur penulisan pada disket model lama (legacy) dinonaktifkan
pada Computer Setup.

Buka Computer Setup lalu aktifkan Legacy Diskette Write in
Storage > Storage Options.

Ada masalah pada transaksi disk.

Penyebab Solusi

Struktur direktori buruk, atau ada masalah pada file. Pada Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties [Properti] >
Tools [Alat Bantu]. Pada Error-checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties [Properti] lalu pilih tab Tools [Alat Bantu]. Pada
Error-checking klik Check Now.

Drive disket tidak dapat membaca disket.

Penyebab Solusi

Anda menggunakan jenis disket yang tidak sesuai untuk jenis
drive tersebut.

Periksa jenis drive yang digunakan kemudian gunakan jenis
disket yang sesuai.

Anda membaca drive yang salah. Periksa huruf drive pada informasi jalur (path).

Disket rusak. Ganti disket dengan yang baru.

Muncul pesan "Invalid system disk".

Penyebab Solusi

Pada drive terdapat disket yang tidak berisi file sistem yang
diperlukan untuk menjalankan komputer.

Bila aktivitas drive sudah berhenti, keluarkan disket, lalu tekan
Spacebar. Komputer seharusnya dijalankan sekarang.

Terjadi kesalahan disket. Hidupkan ulang komputer dengan menekan tombol daya .

Tidak Dapat Mem-boot dari Disket.

Penyebab Solusi

Disket tidak dapat di-boot. Ganti dengan disket yang dapat di-boot.

Boot disket dinonaktifkan pada Computer Setup. 1. Jalankan Computer Setup lalu aktifkan boot disket pada
Storage > Boot Order.

2. Jalankan Computer Setup lalu aktifkan boot disket pada
Storage > Storage Options > Removable Media
Boot.

Tabel 2-3  Mengatasi Masalah Disket (Lanjutan)
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Tidak Dapat Mem-boot dari Disket.

Penyebab Solusi

CATATAN: Kedua langkah ini harus dijalankan karena
fungsi Removable Media Boot pada Computer Setup akan
menggantikan (override) perintah untuk mengaktifkan Boot
Order.

Mode server jaringan diaktifkan dalam Computer Setup. Jalankan Computer Setup lalu nonaktifkan Network Server
Mode pada Security > Password Options.

Boot media lepas dinonaktifkan pada Computer Setup. Jalankan Computer Setup lalu aktifkan Removable Media Boot
pada Storage > Storage Options > Removable Media
Boot.

Tabel 2-3  Mengatasi Masalah Disket (Lanjutan)
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Mengatasi Masalah Hard Drive
Tabel 2-4  Mengatasi Masalah Hard Drive

Terjadi kesalahan hard drive.

Penyebab Solusi

Pada hard disk terdapat sektor yang rusak, atau hard disk tidak
berfungsi.

1. Pada Microsoft Windows XP, klik kanan Start, klik
Explore, lalu pilih salah satu drive. Pilih File >
Properties [Properti] > Tools [Alat Bantu]. Pada Error-
checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties [Properti] lalu pilih tab Tools [Alat Bantu].
Pada Error-checking klik Check Now.

2. Gunakan utilitas untuk mencari dan memblokir
penggunaan sektor yang rusak. Jika perlu, format ulang
hard disk.

Masalah transaksi disk.

Penyebab Solusi

Stuktur direktori buruk, atau ada masalah pada file. Pada Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties [Properti] >
Tools [Alat Bantu]. Pada Error-checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties [Properti] lalu pilih tab Tools [Alat Bantu]. Pada
Error-checking klik Check Now.

Drive tidak ditemukan (teridentifikasi).

Penyebab Solusi

Kabel mungkin longgar. Periksa sambungan kabel.

Sistem mungkin tidak secara otomatis mengenali perangkat
yang baru dipasang.

Lihat petunjuk tentang konfigurasi ulang dalam bagian
Mengatasi Masalah Pemasangan Perangkat Keras
pada hal. 33. Jika sistem masih belum mengenali perangkat
baru tersebut, periksa apakah perangkat tercantum dalam
Computer Setup. Jika tercantum, kemungkinan penyebabnya
adalah masalah driver. Jika tidak tercantum, kemungkinan
penyebabnya adalah masalah perangkat keras.

Jika ini adalah drive yang baru dipasang, jalankan utilitas
Computer Setup lalu coba tambahkan tunda pada opsi
Advanced > Power-On.

Perangkat terhubung ke port SATA yang disetel tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup dan pastikan Device
Available [Perangkat Tersedia] dipilih untuk port SATA di
Security [Keamanan] > Device Security [Keamanan
Perangkat].

Segera setelah penyalaan, drive bereaksi dengan lamban. Jalankan Computer Setup lalu naikkan POST Delay pada
Advanced > Power-On Options.
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Pesan Nonsystem disk/NTLDR missing.

Penyebab Solusi

Sistem mencoba memulai operasi dari disket yang tidak dapat
di-boot.

Keluarkan disket dari drive disket.

Sistem mencoba memulai dari hard drive, tapi hard drive
mungkin rusak.

1. Masukkan disket boot ke dalam drive disket, kemudian
hidupkan ulang komputer.

2. Periksa format hard drive dengan menggunakan fdisk:
Bila menggunakan format NTFS, gunakan alat pembaca
pihak ketiga untuk mengevaluasi drive. Bila
menggunakan format FAT32, hard drive tidak dapat
diakses.

File sistem tidak ada atau tidak diinstal dengan benar. 1. Masukkan disket boot ke dalam drive disket, kemudian
hidupkan ulang komputer.

2. Periksa format hard drive dengan menggunakan Fdisk:
Bila menggunakan format NFTFS, gunakan alat
pembaca pihak ketiga untuk mengevaluasi drive. Bila
menggunakan format FAT32, hard drive tidak dapat
diakses.

3. Instal file sistem dengan sistem operasi yang sesuai.

Boot hard drive dinonaktifkan pada Computer Setup. Jalankan utilitas Computer Setup lalu aktifkan entri hard drive
dalam daftar Storage > Boot Order.

Hard drive boot tidak dipasang sebagai yang pertama dalam
konfigurasi multi hard-drive.

Jika mencoba mem-boot dari hard drive, pastikan hard drive
telah terhubung ke konektor system board berlabel P60
SATA0.

Kontroler hard drive boot tidak terdaftar sebagai yang pertama
dalam Boot Order.

Jalankan utilitas Computer Setup lalu pilih Storage > Boot
Order dan pastikan kontroler hard drive yang dapat di-boot
terdaftar langsung di bawah entri Hard Drive.

Komputer tidak mem-boot dari hard drive.

Penyebab Solusi

Perangkat terhubung ke port SATA yang disetel tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup dan pastikan Device
Available [Perangkat Tersedia] dipilih untuk port SATA di
Security [Keamanan] > Device Security [Keamanan
Perangkat].

Urutan boot tidak benar. Jalankan utilitas Computer Setup lalu ganti urutan boot dalam
Storage > Boot Order.

"Emulation Type" hard drive disetel ke "None." Jalankan utilitas Computer Setup lalu ubah "Emulation Type"
ke "Hard Disk" dalam rincian perangkat pada Storage >
Device Configuration.

Hard drive rusak. Periksa apalah LED daya pada panel depan berkedip MERAH,
dan apakah ada bunyi bip yang terdengar. Lihat Lampiran A,
Pesan Kesalahan POST pada hal. 50 untuk menentukan
kemungkinan penyebab kode lampu berkedip merah dan bip
tersebut.

Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Tabel 2-4  Mengatasi Masalah Hard Drive (Lanjutan)
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Komputer tampaknya terkunci.

Penyebab Solusi

Program yang sedang digunakan tidak lagi bereaksi terhadap
perintah.

Cobalah dengan prosedur "Shut Down" Windows secara
normal. Jika tidak bisa, tekan tombol daya selama empat detik
atau lebih, untuk mematikannya. Untuk menghidupkan ulang
komputer, tekan lagi tombol daya.

Hard drive yang dapat dilepas, tidak dialiri arus daya ke hard drive enclosure.

Penyebab Solusi

Kunci pada enclosure tidak diputar ke posisi "ON". Masukkan kunci lalu putar 90 derajat searah jarum jam. LED
hijau di depan enclosure harus menyala.

Kabel listrik dari catu daya komputer ke bingkai enclosure tidak
terhubung dengan benar.

Periksa catu daya untuk memastikannya sudah terhubung
dengan benar ke bagian belakang bingkai enclosure.

Hard drive yang dapat dilepas tidak dikenali oleh komputer.

Penyebab Solusi

Carrier atau unit pembawa hard drive yang dapat dilepas, tidak
seluruhnya masuk ke dalam bingkai enclosure atau, hard drive
tidak seluruhnya masuk ke dalam dudukan di carrier.

Dorong carrier ke dalam bingkai enclosure agar konektor di
belakang bingkai masuk ke dalam dudukannya dengan benar.
Jika ini tidak berhasil menyelesaikan masalah, matikan
komputer, lepaskan carrier, lalu periksa apakah konektor pada
hard drive sudah didudukkan dengan benar.

Enclosure hard drive yang dapat dilepas mengeluarkan bunyi bip dan LED hijau berkedip.

Penyebab Solusi

Alarm kegagalan kipas pada enclosure hard drive yang dapat
dilepas, sudah diaktifkan.

Matikan komputer lalu hubungi HP untuk minta enclosure
pengganti.

Tabel 2-4  Mengatasi Masalah Hard Drive (Lanjutan)
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Mengatasi Masalah Pembaca Kartu Media
Tabel 2-5  Mengatasi Masalah Pembaca Kartu Media

Kartu media tidak dapat bekerja pada kamera digital setelah diformat pada Microsoft Windows XP atau Microsoft
Windows Vista.

Penyebab Solusi

Secara default, Windows XP dan Windows Vista akan
memformat semua kartu media yang berkapasitas lebih besar
dari 32 MB dengan format FAT32. Sebagian besar kamera
digital menggunakan format FAT (FAT16 & FAT12) dan tidak
dapat bekerja dengan kartu dengan format FAT32.

Format kartu media pada kamera digital atau pilih sistem file
FAT untuk memformat kartu media pada komputer dengan
Windows XP atau Windows Vista.

Kesalahan proteksi tulis atau terkunci terjadi saat mencoba untuk menulis ke kartu media.

Penyebab Solusi

Kartu media terkunci. Mengunci kartu media adalah fitur
keamanan yang pencegah penulisan dan penghapusan kartu
SD/Memory Stick/PRO.

Jika menggunakan kartu SD, pastikan tab kunci di sebelah
kanan kartu SD tidak berada pada posisi terkunci. Jika
menggunakan kartu Memory Stick/PRO, pastikan tab kunci di
bagian bawah kartu Memory Stick/PRO tidak berada pada
posisi terkunci.

Tidak dapat menulis ke kartu media.

Penyebab Solusi

Kartu media adalah kartu memori hanya-baca (ROM). Periksa dokumentasi produsen yang disertakan dengan kartu
Anda untuk melihat apakah kartu dapat ditulis. Lihat daftar
kartu yang kompatibel dalam bagian sebelumnya.

Tidak dapat mengakses data pada kartu media setelah dimasukkan ke slot.

Penyebab Solusi

Kartu media tidak dimasukkan dengan benar, dimasukkan ke
slot yang salah, atau tidak didukung.

Pastikan kartu dimasukkan dengan benar dengan kontak
berwarna emas di sisi yang benar. Lampu LED hijau akan
menyala jika kartu dimasukkan dengan benar.

Tidak tahu cara mengeluarkan kartu media dengan benar.

Penyebab Solusi

Perangkat lunak komputer digunakan untuk mengeluarkan
kartu dengan aman.

Buka My Computer (Windows XP) atau Computer (Windows
Vista), klik kanan ikon drive yang sesuai, lalu pilih Eject.
Kemudian tarik keluar kartu dari slotnya.

CATATAN: Jangan keluarkan kartu bila lampu LED hijau
menyala
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Setelah menginstal pembaca kartu media dan mem-boot ke Windows, pembaca dan kartu yang dimasukkan tidak
dikenali oleh komputer.

Penyebab Solusi

Sistem operasi memerlukan waktu untuk mengenali perangkat
jika pembaca baru diinstal ke komputer dan Anda
menghidupkan PC untuk pertama kalinya.

Tunggu beberapa detik sampai sistem operasi dapat
mengenali pembaca dan port yang tersedia, kemudian
mengenali media apa pun yang dimasukkan ke dalam
pembaca.

Setelah memasukkan kartu media ke dalam pembaca, komputer mencoba mem-boot dari kartu media.

Penyebab Solusi

Kartu media yang dimasukkan memiliki kemampuan boot. Jika Anda tidak ingin mem-boot dari kartu media, keluarkan
kartu saat booting atau jangan pilih opsi untuk mem-boot dari
kartu media yang dimasukkan selama booting.

Tabel 2-5  Mengatasi Masalah Pembaca Kartu Media (Lanjutan)
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Mengatasi Masalah Tampilan
Jika Anda mengalami masalah tampilan, lihat dokumentasi yang disertakan bersama monitor dan lihat
juga daftar penyebab dan solusi umum dalam tabel berikut.

Tabel 2-6  Mengatasi Masalah Tampilan

Layar kosong (tidak ada gambar).

Penyebab Solusi

Monitor belum dihidupkan dan lampu monitor tidak menyala. Hidupkan monitor dan periksa apakah lampu monitor menyala.

Monitor rusak. Cobalah monitor lain.

Sambungan kabel salah. Periksa sambungan kabel dari monitor ke komputer dan ke
stopkontak listrik.

Anda mungkin mengaktifkan utilitas pengosongan layar
monitor, atau fitur hemat energi.

Tekan sembarang tombol atau klik tombol mouse dan jika ada,
ketikkan sandi Anda.

System ROM rusak; sistem yang dijalankan adalah Boot Block
Emergency Recovery Mode (ditunjukkan dengan delapan
bunyi bip).

Flash ulang sistem ROM dengan image BIOS terbaru. Untuk
informasi lebih lanjut, lihat bagian "Boot Block Emergency
Recovery Mode" dalam Panduan Manajemen Desktop

Anda menggunakan monitor fixed-sync (sinkronisasi tetap)
dan monitor ini tidak sinkron dengan resolusi yang dipilih.

Pastikan monitor dapat menerima nilai pindai (scan rate)
horizontal yang sama dengan resolusi yang dipilih.

Komputer berada dalam mode standby (siaga). Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Kabel monitor dihubungkan ke konektor yang salah. Jika sistem komputer dilengkapi dengan konektor gambar
terpadu dan konektor kartu gambar tambahan, pasang kabel
monitor ke konektor kartu gambar pada bagian belakang
komputer.

Pengaturan monitor pada komputer tidak kompatibel dengan
monitornya.

1. Pada Control Panel Windows XP, klik dua kali ikon
Display, lalu pilih tab Settings.

Pada Control Panel Windows Vista, di bawah
Appearance and Personalization, pilih Adjust screen
resolution.

2. Gunakan kontrol geser untuk menyetel ulang resolusi.

Tidak dapat mengaktifkan gambar terpadu setelah menginstal kartu gambar PCI Express.

Penyebab Solusi

Pada sistem dengan grafis terpadu Intel, grafis terpadu tidak
dapat difungsikan setelah menginstal PCI Express x16.

Grafis terpadu dapat difungsikan dalam Computer Setup jika
kartu grafis PCI atau PCI Express x1 dipasang, tetapi tidak
dapat difungsikan jika ada kartu grafis dalam slot PCI Express
x16.
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Tidak ada gambar pada layar dan LED daya berkedip Merah lima kali, setiap detik sekali, diselingi jeda dua detik, dan
komputer berbunyi bip lima kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Error memori pra-video 1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk memisahkan modul yang
bermasalah.

3. Ganti memori pihak ketiga dengan memori HP.

4. Gantilah system board.

Tidak ada gambar pada layar dan LED daya berkedip Merah enam kali, setiap detik sekali, diselingi jeda dua detik, dan
komputer berbunyi bip enam kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Kesalahan gambar pra-video. Untuk sistem yang dilengkapi kartu gambar:

1. Ulangi pemasangan kartu gambar. Hidupkan sistem.

2. Ganti kartu gambar.

3. Gantilah system board.

Untuk sistem dengan gambar terpadu, ganti system board.

Tidak ada gambar pada layar dan LED daya berkedip Merah tujuh kali, setiap detik sekali, diselingi jeda dua detik, dan
komputer berbunyi bip tujuh kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Gangguan system board (masalah ROM yang terdeteksi
sebelum masuk ke video)

Gantilah system board.

Monitor tidak berfungsi dengan benar bila digunakan dengan fitur hemat energi.

Penyebab Solusi

Monitor yang tidak memiliki kapabilitas hemat energi
digunakan dengan fitur hemat energi.

Nonaktifkan fitur hemat energi monitor.

Karakter redup.

Penyebab Solusi

Kontrol kecerahan dan kontras tidak diatur dengan benar. Ubah kontrol kecerahan dan kontras monitor.

Kabel tidak disambungkan dengan benar. Periksa apakah kabel gambar sudah terpasang dengan kuat
ke kartu gambar dan monitor.

Video buram atau resolusi yang diminta tidak dapat diaktifkan.

Penyebab Solusi

Jika kontroler gambar pernah ditingkatkan, mungkin Anda
belum menyesuaikan driver gambar.

Instal driver video yang disertakan dalam kit peningkatan
tersebut.
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Video buram atau resolusi yang diminta tidak dapat diaktifkan.

Penyebab Solusi

Monitor tidak punya kemampuan untuk menampilkan resolusi
yang diminta.

Ubah informasi yang diminta.

Kartu gambar rusak. Ganti kartu gambar.

Gambar terpecah-pecah, bergulung, bergerak-gerak, atau berkedip-kedip.

Penyebab Solusi

Sambungan monitor mungkin tidak lengkap, atau monitor
belum disesuaikan dengan benar.

1. Pastikan kabel monitor terpasang dengan kuat pada
komputer.

2. Pada sistem dua monitor atau jika ada monitor lain yang
letaknya berdekatan, pastikan kedua monitor tidak saling
menimbulkan interferensi medan elektromagnetik
dengan menjauhkannya.

3. Lampu fluoresen atau kipas mungkin terlalu dekat ke
monitor.

Medan magnet monitor perlu dihilangkan (degauss). Lakukan pembuangan medan magnet monitor. Untuk
petunjuk, lihat dokumentasi yang disertakan bersama monitor.

Gambar tidak berada di tengah.

Penyebab Solusi

Posisi gambar harus diatur. Tekan tombol Menu monitor untuk membuka menu OSD. Pilih
ImageControl/ Horizontal Position atau Vertical Position
untuk mengatur posisi horizontal atau vertikal gambar.

"No Connection, Check Signal Cable" terlihat pada layar.

Penyebab Solusi

Kabel video monitor tidak terhubung. Hubungkan kabel video antara monitor dan komputer.

PERHATIAN: Pastikan komputer sudah dimatikan sebelum
menghubungkan kabel video.

"Out of Range" terlihat pada layar.

Penyebab Solusi

Resolusi video dan nilai refresh diatur lebih tinggi dari yang
didukung oleh monitor.

Hidupkan ulang komputer dan masuk ke Safe Mode. Ubah
pengaturan ke pengaturan yang sesuai, kemudian hidupkan
ulang komputer untuk mengaktifkan pengaturan tersebut.

Ada suara getar atau gemeretak berasal dari dalam monitor CRT saat monitor dihidupkan.

Penyebab Solusi

Koil pembuangan medan magnet pada monitor diaktifkan. None. Ini normal jika koil pembuangan medan magnet aktif
saat monitor dihidupkan.

Tabel 2-6  Mengatasi Masalah Tampilan (Lanjutan)
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Ada suara 'klik-klik' dari dalam monitor CRT.

Penyebab Solusi

Relai elektronik di dalam monitor diaktifkan. None. Pada jenis monitor tertentu, bunyi 'klik-klik' ini normal
saat monitor dihidupkan dan dimatikan, ketika masuk ke dan
keluar dari mode siaga, dan saat berganti resolusi.

Terdengar suara lengking tinggi dari dalam monitor layar datar.

Penyebab Solusi

Pengaturan kecerahan dan/atau kontras terlalu tinggi. Turunkan pengaturan kecerahan dan/atau kontras.

Fokus acak; efek garis, efek gambar ganda, atau bayangan; garis bergulung horizontal; garis vertikal tipis, atau tidak
dapat menempatkan gambar di tengah layar (hanya monitor panel datar yang menggunakan koneksi input VGA).

Penyebab Solusi

Rangkaian konversi digital pada monitor layar datar mungkin
tidak dapat merespon sinkronisasi output pada kartu gambar
dengan benar.

1. Pilih pilihan Auto-Adjustment monitor pada menu
tampilan layar monitor.

2. Sinkronisasikan fungsi tampilan layar Clock dan Clock
Phase secara manual. Untuk men-download SoftPaq
yang dapat membantu Anda melakukan sinkronisasi ini,
kunjungi situs Web berikut, pilih monitor yang sesuai, dan
download SP32347 atau SP32202: http://www.hp.com/
support

Kartu gambar tidak terpasang kuat atau kartu gambar rusak. 1. Ulangi pemasangan kartu gambar.

2. Ganti kartu gambar.

Beberapa simbol yang diketikkan tidak ditampilkan dengan benar.

Penyebab Solusi

Jenis huruf yang digunakan tidak mendukung simbol tersebut. Gunakan Character Map untuk mencari dan memilih simbol
yang sesuai. Klik Start > All Programs > Accessories >
System Tools > Character Map. Anda dapat menyalin simbol
ini dari Character Map ke dokumen.

Tabel 2-6  Mengatasi Masalah Tampilan (Lanjutan)
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Mengatasi Masalah Audio
Jika komputer memiliki fitur audio dan Anda mengalami masalah audio, lihat daftar penyebab dan solusi
umum dalam tabel berikut.

Tabel 2-7  Mengatasi Masalah Audio

Suara terputus-putus.

Penyebab Solusi

Sumber daya prosesor sedang digunakan oleh aplikasi lain
yang terbuka.

Tutup semua aplikasi yang intensif menggunakan prosesor.

Suara bawaan, umumnya terdapat pada berbagai aplikasi
pemutar media.

Hanya pada Windows XP:

1. Dari Control Panel, pilih Sounds and Audio Devices.

2. pada tab Audio, pilih perangkat dari daftar Sound
Playback.

3. Klik tombol Advanced dan pilih tab Performance.

4. Atur indikator geser Hardware acceleration ke None
dan indikator geser Sample rate conversion quality ke
Good, kemudian uji ulang audio.

5. Atur indikator geser Hardware acceleration ke Full dan
indikator geser Sample rate conversion quality ke
Best, kemudian tes ulang audio.

Suara tidak keluar dari pengeras suara atau headphone.

Penyebab Solusi

Kontrol volume perangkat lunak diturunkan atau diredam. Klik dua kali ikon Speaker pada bilah tugas, kemudian
pastikan Mute tidak dipilih, lalu gunakan bilah geser volume
untuk mengatur volume.

Audio tidak ditampilkan pada Computer Setup. Aktifkan audio dalam Computer Setup: Security > Device
Security > Audio.

Pengeras suara eksternal tidak dihidupkan. Hidupkan pengeras suara eksternal.

Perangkat audio mungkin terhubung ke jack yang salah. Pastikan perangkat terhubung ke jack yang benar pada
komputer. Speaker harus dicolokkan ke jack line-out belakan
dan headphone harus dicolokkan ke jack headphone depan.

Pengeras suara eksternal disambungkan ke soket audio yang
salah pada kartu suara yang baru diinstal.

Lihat dokumentasi kartu suara untuk mengetahui sambungan
pengeras suara yang benar.

Audio CD digital tidak diaktifkan. Aktifkan audio CD digital. Pada Device Manager, klik kanan
perangkat CD/DVD, kemudian pilih Properties. Pastikan
Enable digital CD audio for this CD-ROM device (Aktifkan
audio CD digital untuk perangkat CD-ROM ini) dicentang.

Adanya headphone atau perangkat yang terpasang ke
konektor line-out (saluran keluar) akan meredam suara dari
pengeras suara internal.

Jika terpasang, hidupkan dan gunakan headphone atau
pengeras suara tersebut. Jika tidak digunakan, lepaskan
headphone atau pengeras suara eksternal.
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Suara tidak keluar dari pengeras suara atau headphone.

Penyebab Solusi

Komputer berada dalam mode standby (siaga). Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Speaker internal dilumpuhkan dalam Computer Setup. Fungsikan speaker internal dalam Computer Setup. Pilih
Advanced [Tingkat Lanjut] > Device Options [Opsi
Perangkat] > Internal Speaker [Speaker Internal].

Suara dari headphone tidak jernih atau berdesis.

Penyebab Solusi

Headphone disambungkan ke konektor output audio
belakang. Konektor output audio belakang adalah untuk
menghidupkan perangkat audio dan tidak didesain untuk
penggunaan headphone.

Hubungkan headphone ke konektor headphone di bagian
depan komputer.

Komputer tampak terkunci sewaktu merekam audio.

Penyebab Solusi

Hard disk mungkin penuh. Sebelum merekam, pastikan terdapat cukup ruang kosong
pada hard disk. Anda juga dapat mencoba merekam file audio
dalam format kompresi.

Fitur jack line-in tidak berfungsi baik.

Penyebab Solusi

Jack telah dikonfigurasikan pada driver audio atau perangkat
lunak aplikasi.

Pada driver audio atau perangkat lunak aplikasi,
konfigurasikan ulang jack atau setel jack tersebut ke nilai
default-nya.
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Mengatasi Masalah Printer
Jika Anda mengalami masalah printer, lihat dokumentasi yang disertakan dengan printer dan lihat juga
daftar penyebab dan solusi umum dalam tabel berikut.

Tabel 2-8  Mengatasi Masalah Printer

Printer tidak mencetak.

Penyebab Solusi

Printer belum dihidupkan dan tidak terhubung. Hidupkan printer dan pastikan printer terhubung.

Driver printer yang sesuai untuk aplikasi tersebut belum
diinstal.

1. Instal driver printer yang sesuai untuk aplikasi tersebut.

2. Cobalah mencetak menggunakan perintah MS-DOS:

DIR C:\ > [port printer]

di mana [port printer] adalah alamat printer yang
digunakan. Jika printer berfungsi baik, aktifkan driver printer.

Jika komputer Anda berada pada jaringan, Anda mungkin
belum menghubungkannya ke printer.

Buatlah sambungan yang benar ke printer jaringan.

Printer mungkin tidak berfungsi. Jalankan swauji printer.

Printer tidak dapat dihidupkan.

Penyebab Solusi

Kabel-kabelnya mungkin tidak terhubung dengan benar. Sambungkan ulang semua kabel, dan periksa kabel daya serta
stopkontak listrik.

Printer mencetak informasi yang tidak dapat dipahami.

Penyebab Solusi

Driver printer yang sesuai untuk aplikasi tersebut belum
diinstal.

Instal driver printer yang sesuai untuk aplikasi tersebut.

Kabel-kabelnya mungkin tidak terhubung dengan benar. Sambungkan ulang semua kabel.

Memori printer mungkin kelebihan beban. Setel ulang printer dengan mematikannya selama satu menit,
kemudian hidupkan kembali.

Printer tidak terhubung.

Penyebab Solusi

Printer mungkin kehabisan kertas. Periksa baki kertas, isilah bila kosong. Pilih online.
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Mengatasi Masalah Keyboard dan Mouse
Jika Anda mengalami masalah pada keyboard atau mouse, lihat dokumentasi yang menyertai peralatan
tersebut dan lihat juga daftar penyebab dan solusi umum dalam tabel berikut.

Tabel 2-9  Mengatasi Masalah Keyboard

Perintah dan masukan dari keyboard tidak dikenali oleh komputer.

Penyebab Solusi

Konektor keyboard tidak terpasang dengan benar. 1. Pada Desktop Windows XP, klik Start > Shut Down.

Pada Desktop Windows Vista, klik Start, klik tanda panah
di sudut kanan bawah menu Start, lalu pilih Shut Down.

2. Setelah shutdown selesai, sambungkan lagi keyboard ke
bagian belakang komputer, kemudian hidupkan ulang
komputer.

Program yang sedang digunakan tidak lagi bereaksi terhadap
perintah.

Matikan komputer dengan menggunakan mouse, kemudian
hidupkan ulang komputer.

Keyboard perlu diperbaiki. Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Kesalahan perangkat nirkabel. 1. Periksa perangkat lunak, jika ada, untuk status
perangkat.

2. Periksa/ganti baterai perangkat.

3. Setel ulang alat penerima dan keyboard.

Komputer berada dalam mode standby (siaga). Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Kursor tidak dapat digerakkan dengan menggunakan tombol arrow pada papan tombol.

Penyebab Solusi

Tombol Num Lock mungkin aktif. Tekan tombol Num Lock. Lampu NumLock tidak boleh
menyala jika Anda ingin menggunakan tombol arrow. Tombol
Num Lock dapat dilumpuhkan (atau difungsikan) dalam
Computer Setup.

Tabel 2-10  Mengatasi Masalah Mouse

Mouse tidak bereaksi terhadap gerakan atau terlalu lamban.

Penyebab Solusi

Konektor mouse tidak terpasang dengan benar ke bagian
belakang komputer.

Matikan komputer dengan menggunakan keyboard.

1. Tekan tombol Ctrl dan Esc secara bersamaan (atau tekan
tombol Windows logo) untuk menampilkan menu Start.

2. Gunakan tombol panah untuk memilih Shut Down lalu
tekan tombol Enter.

3. Setelah shutdown selesai, sambungkan kembali
konektor mouse ke bagian belakang komputer (atau
keyboard), kemudian hidupkan ulang komputer.
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Mouse tidak bereaksi terhadap gerakan atau terlalu lamban.

Penyebab Solusi

Program yang sedang digunakan tidak lagi bereaksi terhadap
perintah.

Matikan komputer dengan menggunakan keyboard, kemudian
hidupkan ulang komputer.

Mouse mungkin perlu dibersihkan. Lepaskan penutup bola penggulung pada mouse, kemudian
bersihkan komponen internal.

Mouse mungkin perlu diperbaiki. Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Kesalahan perangkat nirkabel. 1. Periksa perangkat lunak, jika ada, untuk status
perangkat.

2. Periksa/ganti baterai perangkat.

3. Setel ulang alat penerima dan mouse.

Komputer berada dalam mode standby (siaga). Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Mouse hanya dapat bergerak ke atas, ke samping, atau gerakannya tidak mulus.

Penyebab Solusi

Bola penggulung mouse atau as enkoder putaran yang
menyentuh bola kotor.

Lepaskan bola penggulung di bagian dasar mouse, kemudian
bersihkan komponen internal dengan kit pembersih mouse
yang tersedia di toko komputer.

Tabel 2-10  Mengatasi Masalah Mouse (Lanjutan)
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Mengatasi Masalah Pemasangan Perangkat Keras
Anda mungkin perlu mengkonfigurasi ulang komputer setelah menambah atau melepaskan perangkat
keras, misalnya drive tambahan atau kartu ekspansi. Jika Anda memasang perangkat plug and play,
Windows secara otomatis akan mengenali perangkat tersebut dan mengkonfigurasikan komputer. Jika
Anda memasang perangkat non-plug and play, Anda harus mengkonfigurasikan komputer setelah
menyelesaikan pemasangan perangkat keras baru tersebut. Pada Windows, gunakan Add Hardware
Wizard, lalu ikuti petunjuk di layar.

PERINGATAN! Bila komputer dihubungkan ke stopkontak listrik AC, selalu ada tegangan pada
system board. Untuk mengurangi risiko cedera dari sengatan listrik dan/atau permukaan panas,
pastikan untuk melepaskan kabel daya dari dtopkontak di dinding dan biarkan komponen sistem internal
mendingin sebelum menyentuhnya.

Tabel 2-11  Mengatasi Masalah Pemasangan Perangkat Keras

Perangkat baru tidak dikenali sebagai bagian dari sistem.

Penyebab Solusi

Perangkat tidak terletak atau terpasang dengan benar. Pastikan perangkat tersebut terhubung dengan benar dan
kuat, dan tidak ada pin konektor yang tertekuk.

Kabel perangkat eksternal baru tersebut longgar atau kabel
dayanya terlepas.

Pastikan semua kabel terhubung dengan benar dan kuat, dan
tidak ada pin pada kabel konektor yang tertekuk.

Saklar daya pada perangkat eksternal baru tersebut belum
dinyalakan.

Matikan komputer, hidupkan perangkat eksternal, kemudian
hidupkan komputer untuk mengintegrasikan perangkat
tersebut ke sistem komputer.

Ketika sistem memberi tahu Anda tentang perubahan
konfigurasi, Anda menolaknya.

Boot ulang komputer, kemudian ikuti petunjuk untuk menerima
perubahan tersebut.

Ketika dipasang, papan plug and play tidak akan secara
otomatis dikonfigurasikan jika konfigurasi default-nya
menimbulkan konflik dengan perangkat lain.

Gunakan Windows Device Manager untuk membatalkan
pemilihan pengaturan otomatis untuk papan tersebut,
kemudian pilih konfigurasi dasar yang tidak menimbulkan
konflik sumber daya. Anda juga dapat menggunakan
Computer Setup untuk melakukan konfigurasi ulang atau
melumpuhkan perangkat untuk mengatasi konflik sumber
daya tersebut.

Port USB pada komputer dinonaktifkan pada Computer Setup. Buka Computer Setup (F10) lalu aktifkan port USB.

Komputer tidak dapat dihidupkan.

Penyebab Solusi

Modul memori yang digunakan untuk peningkatan tidak sesuai
atau modul memori dipasang pada lokasi yang salah.

1. Lihat dokumentasi yang disertakan bersama sistem
untuk menentukan apakah Anda menggunakan modul
memori yang benar dan untuk memeriksa apakah
pemasangan sudah benar.

CATATAN: DIMM 1 harus selalu terpasang.

2. Perhatikan bunyi bip dan LED yang menyala di bagian
depan komputer. Bip dan LED berkedip adalah kode
untuk masalah tertentu.

3. Jika Anda masih belum dapat mengatasi masalah ini,
hubungi Dukungan Pelanggan.
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LED daya berkedip Merah lima kali, satu kali per detik, diselingi jeda dua detik, kemudian komputer berbunyi bip lima
kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Pemasangan memori salah atau memori rusak. PERHATIAN: Untuk menghindari kerusakan pada DIMM
atau system board, Anda harus melepaskan kabel daya
komputer sebelum mencoba mengatur ulang dudukan,
menginstal, atau melepaskan modul DIMM.

1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk memisahkan modul yang
bermasalah.

CATATAN: DIMM 1 harus selalu terpasang.

3. Ganti memori pihak ketiga dengan memori HP.

4. Gantilah system board.

LED daya berkedip Merah enam kali, satu kali per detik, diselingi jeda dua detik, kemudian komputer berbunyi bip
enam kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Kartu gambar tidak terpasang dengan benar atau rusak, atau
papan sistem rusak.

Untuk sistem yang dilengkapi kartu gambar:

1. Ulangi pemasangan kartu gambar. Hidupkan sistem.

2. Ganti kartu gambar.

3. Gantilah system board.

Untuk sistem dengan gambar terpadu, ganti system board.

LED daya berkedip Merah sepuluh kali, satu kali per detik, diselingi jeda dua detik, kemudian komputer berbunyi bip
sepuluh kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Kartu tambahan rusak. 1. Periksa setiap kartu tambahan dengan melepaskan kartu
satu per satu (jika terpasang banyak kartu), kemudian
hidupkan sistem untuk melihat apakah masalah teratasi.

2. Setelah kartu yang rusak ditemukan, lepaskan lalu ganti
kartu tambahan tersebut.

3. Gantilah system board.

Tabel 2-11  Mengatasi Masalah Pemasangan Perangkat Keras (Lanjutan)
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Mengatasi Masalah Jaringan
Beberapa penyebab dan solusi umum untuk masalah jaringan tercantum dalam tabel berikut ini.
Panduan ini tidak membahas proses debugging (mencari lokasi kesalahan) kabel jaringan.

Tabel 2-12  Mengatasi Masalah Jaringan

Fitur Wake-on-LAN tidak berfungsi.

Penyebab Solusi

Fitur Wake-on-LAN tidak diaktifkan. Untuk mengaktifkan Wake-on-LAN pada Windows XP:

1. Pilih Start > Control Panel.

2. Klik dua kali Network Connections.

3. Klik dua kali Local Area Connection.

4. Klik Properties.

5. Klik Configure.

6. Klik tab Power Management, kemudian pilih kotak
centang untuk Allow this device to bring the computer
out of standby.

Untuk mengaktifkan Wake-on-LAN pada Windows Vista:

1. Pilih Start [Mulai] > Control Panel [Panel Kontrol].

2. Di bawah Network and Internet, pilih View network
status and tasks.

3. Dalam daftar Tasks (Tugas), pilih Manage network
connections (Kelola koneksi jaringan).

4. Klik dua kali Local Area Connection.

5. Klik tombol Properties.

6. Klik tombol Configure.

7. Klik tab Power Management, kemudian pilih kotak
centang untuk Allow this device to bring the computer
out of standby.

Driver jaringan tidak mendeteksi kontroler jaringan.

Penyebab Solusi

Kontroler jaringan dinonaktifkan. 1. Jalankan Computer Setup, kemudian aktifkan kontroler
jaringan.

2. Aktifkan kontroler jaringan pada sistem operasi melalui
Device Manager.

Driver jaringan tidak sesuai. Lihat dokumentasi kontroler jaringan untuk driver yang sesuai
atau untuk mendapatkan driver versi terbaru dari situs Web
produsen.
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Lampu link status jaringan tidak menyala.

CATATAN: Lampu status jaringan seharusnya berkedip bilamana ada aktivitas jaringan.

Penyebab Solusi

Tidak terdeteksi adanya jaringan yang aktif. Periksa apakah sambungan kabel dan sambungan perangkat
sudah benar.

Kontroler jaringan tidak diatur dengan benar. Periksa status perangkat dari Windows, seperti Device
Manager untuk mengetahui pemasangan driver, serta applet
Network Connections di Windows untuk mengetahui status
link.

Kontroler jaringan dinonaktifkan. 1. Jalankan Computer Setup, kemudian aktifkan kontroler
jaringan.

2. Aktifkan kontroler jaringan pada sistem operasi melalui
Device Manager.

Driver jaringan tidak diinstal dengan benar. Ulangi penginstalan driver jaringan.

Sistem tidak dapat melakukan penginderaan otomatis
(autosense) jaringan.

Nonaktifkan kapabilitas penginderaan otomatis dan paksa
sistem untuk masuk ke mode operasi yang benar.

Diagnostik melaporkan adanya kegagalan.

Penyebab Solusi

Kabel tidak tersambung dengan kuat. Pastikan kabel terpasang kuat ke konektor jaringan dan ujung
lain dari kabel terpasang kuat ke perangkat yang sesuai.

Kabel terpasang ke konektor yang salah. Pastikan kabel terpasang ke konektor yang benar.

Ada masalah pada kabel atau pada perangkat yang terhubung
ke ujung lain dari kabel.

Pastikan kabel dan perangkat yang terhubung pada kabel
tersebut beroperasi dengan benar.

Interupsi kontroler jaringan dipakai bersama dengan papan
ekspansi.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan tersebut.

Kontroler jaringan rusak. Hubungi penyedia servis resmi.

Diagnostik berhasil, namun komputer tidak berkomunikasi dengan jaringan.

Penyebab Solusi

Driver jaringan belum diinstal, atau parameter driver tidak
cocok dengan konfigurasi yang aktif.

Pastikan driver jaringan sudah diaktifkan dan parameter driver
cocok dengan konfigurasi kontroler jaringan.

Pastikan klien jaringan dan protokol yang diinstal sudah benar.

Kontroler jaringan tidak dikonfigurasikan untuk komputer ini. Pilih ikon Network pada Control Panel, kemudian
konfigurasikan kontroler jaringan.

Kontroler jaringan berhenti bekerja jika ada papan ekspansi yang ditambahkan pada komputer.

Penyebab Solusi

Interupsi kontroler jaringan dipakai bersama dengan papan
ekspansi.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan tersebut.

Tabel 2-12  Mengatasi Masalah Jaringan (Lanjutan)
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Kontroler jaringan berhenti bekerja jika ada papan ekspansi yang ditambahkan pada komputer.

Penyebab Solusi

Kontroler jaringan memerlukan driver. Pastikan driver tidak terhapus secara tidak sengaja ketika
berlangsung penginstalan driver untuk papan ekspansi yang
baru.

Papan ekspansi yang dipasang adalah kartu jaringan (NIC)
dan menimbulkan konflik dengan NIC terbenam.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan tersebut.

Kontroler jaringan berhenti bekerja tanpa sebab yang jelas.

Penyebab Solusi

File yang berisi driver jaringan bermasalah. Instal ulang driver jaringa dengan menggunakan Set Disc
Pemulihan yang dibuat dari Partisi Pemulihan hard drive.

Kabel tidak tersambung dengan kuat. Pastikan kabel terpasang kuat ke konektor jaringan dan ujung
lain dari kabel terpasang kuat ke perangkat yang sesuai.

Kontroler jaringan rusak. Hubungi penyedia servis resmi.

Kartu jaringan yang baru tidak melakukan boot.

Penyebab Solusi

Kartu jaringan yang baru tersebut mungkin rusak, atau tidak
memenuhi spesifikasi standar industri.

Pasang NIC yang memenuhi standar industri dan berfungsi
baik, atau ubah urutan boot agar boot dilakukan dari sumber
lain.

Tidak dapat terhubung ke server jaringan bila mencoba Remote System Installation (penginstalan sistem secara
remote).

Penyebab Solusi

Kontroler jaringan tidak dikonfigurasikan dengan benar. Periksa kebenaran konektivitas jaringan (Network
Connectivity), pastikan bahwa ada DHCP Server, dan bahwa
Remote System Installation Server berisi driver NIC untuk NIC
yang Anda gunakan.

Utilitas pengaturan sistem (system setup) melaporkan EEPROM tak terprogram.

Penyebab Solusi

EEPROM tak terprogram. Hubungi penyedia servis resmi.

Tabel 2-12  Mengatasi Masalah Jaringan (Lanjutan)
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Mengatasi Masalah Memori
Jika Anda mengalami masalah memori, beberapa penyebab dan solusi umum tercantum dalam tabel
berikut ini.

PERHATIAN: Daya mungkin masih mengalir ke DIMM ketika komputer dimatikan (tergantung setelan
Management Engine (ME)). Untuk menghindari kerusakan pada DIMM atau system board, Anda harus
melepaskan kabel daya komputer sebelum mencoba mengatur ulang dudukan, menginstal, atau
melepaskan modul DIMM.

Untuk sistem-sistem yang mendukung memori ECC, HP tidak mendukung penggabungan memori ECC
dengan non-ECC. Jika digabung, komputer tidak dapat mem-boot sistem operasi.

CATATAN: Jumlah memori mungkin terpengaruh oleh konfigurasi dengan Management Engine (ME)
diaktifkan. ME menggunakan memori sistem 8 MB pada mode kanal tunggal atau memori 16MB pada
mode kanal ganda untuk men-download, men-dekompresi, dan menjalankan firmware ME untuk fungsi
Out-of-Band (OOB), penyimpanan data pihak ketiga, dan fungsi manajemen lainnya.

Tabel 2-13  Mengatasi Masalah Memori

Sistem tidak melakukan boot atau tidak berfungsi dengan benar setelah pemasangan modul memori tambahan.

Penyebab Solusi

Modul memori tidak terpasang dalam soket XMM1 (atau
DIMM1).

Pastikan modul memori terpasang dalam soket XMM1 hitam
(atau DIMM1) pada system board. This socket must be
populated with a memory module.

Jenis atau tingkat kecepatan modul memori tersebut tidak
cocok untuk sistem atau modul memori baru tersebut tidak
terpasang dengan benar.

Gantilah modul dengan perangkat yang memenuhi standar
industri yang sesuai untuk komputer tersebut. Pada model
tertentu, modul memori ECC dan non-ECC tidak dapat
digabungkan.

Kesalahan memori habis.

Penyebab Solusi

Konfigurasi memori tidak diatur dengan benar. Gunakan Device Manager untuk memeriksa konfigurasi
memori.

Anda kekurangan memori untuk menjalankan aplikasi
tersebut.

Lihat dokumentasi aplikasi tersebut untuk mengetahui
kebutuhan memorinya.

Hitungan memori dalam POST salah.

Penyebab Solusi

Modul memori mungkin tidak dipasang dengan benar. Periksa apakah modul memori sudah terpasang dengan benar
dan apakah modul yang digunakan sudah benar.

Gambar terpadu mungkin menggunakan memori sistem. Tidak perlu tindakan apa-apa.

Kesalahan memori yang tidak cukup sewaktu pengoperasian.

Penyebab Solusi

Terlalu banyak program Terminate and Stay Resident (TSR)
yang diinstal.

Hapus TSR yang tidak diperlukan.

Anda kekurangan memori untuk aplikasi tersebut. Periksa kebutuhan memori untuk aplikasi tersebut atau
tambah memori komputer.
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LED daya berkedip Merah lima kali, satu kali per detik, diselingi jeda dua detik, kemudian komputer berbunyi bip lima
kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala.)

Penyebab Solusi

Pemasangan memori salah atau memori rusak. 1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk memisahkan modul yang
bermasalah.

3. Ganti memori pihak ketiga dengan memori HP.

4. Gantilah system board.

Tabel 2-13  Mengatasi Masalah Memori (Lanjutan)
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Mengatasi Masalah Prosesor
Jika Anda mengalami masalah prosesor, beberapa penyebab dan solusi umum tercantum dalam tabel
berikut ini.

Tabel 2-14  Mengatasi Masalah Prosesor

Kinerja komputer buruk.

Penyebab Solusi

Prosesor panas. 1. Pastikan aliran udara ke komputer tidak terhalang.

2. Pastikan kipas terhubung dan berfungsi dengan baik
(kipas tertentu hanya beroperasi jika diperlukan).

3. Pastikan alat pendingin (heatsink) prosesor dipasang
dengan benar.

LED daya berkedip Merah tiga kali, setiap detik sekali, diselingi jeda dua detik.

Penyebab Solusi

Prosesor tidak terpasang dengan benar atau tidak dipasang
sama sekali.

1. Periksa apakah prosesor ada.

2. Ulangi pemasangan prosesor.

LED daya berkedip Merah sebelas kali, setiap detik sekali, diikuti dengan jeda dua detik.

Penyebab Solusi

Prosesor yang sekarang tidak mendukung fitur yang
sebelumnya difungsikan pada sistem ini.

1. Menginstal prosesor berkemampuan TXT.

2. Melumpuhkan TXT dalam utilitas Computer Setup (F10).

3. Menginstal ulang prosesor asli.
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Mengatasi Masalah CD-ROM dan DVD
Jika Anda mengalami masalah CD-ROM atau DVD, lihat daftar penyebab yang umum beserta solusinya
dalam tabel berikut atau lihat dokumentasi yang menyertai perangkat tambahan tersebut.

Tabel 2-15  Mengatasi Masalah CD-ROM dan DVD

Sistem tidak mem-boot dari drive CD-ROM atau DVD.

Penyebab Solusi

Perangkat terhubung ke port SATA yang telah disembunyikan
dalam utilitas Computer Setup.

Jalankan utilitas Computer Setup dan pastikan Device
Available [Perangkat Tersedia] dipilih untuk port SATA di
Security [Keamanan] > Device Security [Keamanan
Perangkat].

Media Boot Lepas dinonaktifkan dalam utilitas Computer
Setup.

Jalankan utilitas Computer Setup, kemudian aktifkan 'booting
to removable media' dalam Storage > Storage Options.
Pastikan CD-ROM diaktifkan dalam Storage > Boot Order.

Network Server Mode diaktifkan dalam Computer Setup. Jalankan utilitas Computer Setup lalu nonaktifkan Network
Server Mode dalam Security > Password Options.

Pada drive terdapat CD non-boot. Masukkan CD boot ke dalam drive.

Urutan boot tidak sesuai. Jalankan utilitas Computer Setup lalu ganti urutan boot dalam
Storage > Boot Order.

Drive tidak ditemukan (teridentifikasi).

Penyebab Solusi

Kabel mungkin longgar. Periksa sambungan kabel.

Sistem mungkin tidak secara otomatis mengenali perangkat
yang baru dipasang.

Lihat petunjuk tentang konfigurasi ulang dalam bagian
Mengatasi Masalah Pemasangan Perangkat Keras
pada hal. 33. Jika sistem masih belum mengenali perangkat
baru tersebut, periksa apakah perangkat tercantum dalam
Computer Setup. Jika tercantum, kemungkinan penyebabnya
adalah masalah driver. Jika tidak tercantum, kemungkinan
penyebabnya adalah masalah perangkat keras.

Jika ini adalah drive yang baru dipasang, jalankan utilitas
Computer Setup lalu coba tambahkan tunda pada opsi
Advanced > Power-On.

Perangkat terhubung ke port SATA yang disetel tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup dan pastikan Device
Available [Perangkat Tersedia] dipilih untuk port SATA di
Security [Keamanan] > Device Security [Keamanan
Perangkat].

Segera setelah penyalaan, drive bereaksi dengan lamban. Jalankan Computer Setup lalu naikkan POST Delay pada
Advanced > Power-On Options.

Perangkat CD-ROM atau DVD tidak terdeteksi atau driver tidak diinstal.

Penyebab Solusi

Drive tidak tersambung atau tidak dikonfigurasikan dengan
benar.

Lihat dokumentasi yang menyertai perangkat tambahan
tersebut.

IDWW Mengatasi Masalah CD-ROM dan DVD 41



Drive DVD tidak dapat memutar film.

Penyebab Solusi

Film tersebut memiliki kode yang tidak sesuai untuk negara/
kawasan Anda.

Lihat dokumentasi yang menyertai drive DVD tersebut.

Perangkat lunak dekoder (pengurai kode) tidak diinstal. Instal perangkat lunak dekoder.

Media rusak. Ganti media.

Peringkat film tersebut termasuk yang diblok oleh parental lock
(pengawasan orang tua).

Gunakan perangkat lunak DVD untuk membatalkan parental
lock.

Media dipasang terbalik. Pasang lagi media.

CD tidak dapat dikeluarkan (tempat pengisian).

Penyebab Solusi

CD tidak terletak dengan benar dalam drive. Matikan komputer, kemudian sisipkan sebatang logam yang
runcing ke dalam lubang darurat, lalu tekan dengan kuat.
Dengan perlahan, tarik tempat CD keluar sepenuhnya dari
drive, kemudian ambil CD.

Drive CD-ROM, CD-RW, DVD-ROM, atau DVD-R/RW tidak dapat membaca disk atau terlalu lama memulai
pengoperasian.

Penyebab Solusi

Media dimasukkan secara terbalik. Masukkan kembali media dengan label menghadap atas.

Drive DVD-ROM terlalu lama memulai operasi karena harus
menentukan jenis media yang akan diputar, misalnya apakah
audio atau video.

Tunggu sedikitnya 30 detik untuk memberi kesempatan pada
drive DVD-ROM untuk menentukan jenis media yang akan
diputar. Jika disc tersebut masih belum bisa diputar, bacalah
solusi lain yang tercantum untuk topik ini.

CD atau DVD tersebut kotor. Bersihkan CD atau DVD dengan kit pembersih CD, yang dapat
diperoleh di toko komputer.

Windows tidak mendeteksi drive CD-ROM atau DVD-ROM. 1. Gunakan Device Manager untuk menghapus instalasi
perangkat tersebut.

2. Hidupkan ulang komputer, dan biarkan Windows
mendeteksi driver CD atau DVD tersebut.

Perekaman atau penyalinan CD tidak dapat atau sulit dilakukan.

Penyebab Solusi

Jenis media tidak sesuai atau berkualitas buruk. 1. Cobalah menggunakan kecepatan yang lebih rendah
untuk merekam.

2. Periksa apakah media yang digunakan untuk drive
tersebut sudah benar.

3. Cobalah merek media yang lain. Kualitas media dari
setiap produsen berbeda-beda.

Tabel 2-15  Mengatasi Masalah CD-ROM dan DVD (Lanjutan)
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Komputer USDT mem-boot terlalu lamban setelah menghapus drive CD-ROM atau DVD.

Penyebab Solusi

Sistem mencari drive saat booting karena kabel drive masih
terhubung ke system board.

Lepaskan kabel drive dari system board.
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Mengatasi Masalah Drive Key
Jika Anda mengalami masalah Drive Key, beberapa penyebab yang umum beserta solusinya tercantum
dalam tabel berikut ini.

Tabel 2-16  Mengatasi Masalah Drive Key

USB Drive Key tidak terlihat sebagai huruf drive dalam Windows.

Penyebab Solusi

Huruf drive setelah drive fisik terakhir tidak tersedia. Gantilah huruf drive default untuk Drive Key tersebut dalam
Windows.

USB Drive Key tidak ditemukan (teridentifikasi).

Penyebab Solusi

Perangkat terhubung ke port USB yang disetel tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup dan pastikan "Device
available" dipilih untuk "All USB Ports" dan "Front USB Ports"
pada Security > Device Security.

Perangkat tidak terpasang dengan benar sebelum dihidupkan. Pastikan perangkat dimasukkan sepenuhnya ke dalam port
USB sebelum menghidupkan daya sistem

Sistem tidak mem-boot dari USB Drive Key.

Penyebab Solusi

Urutan boot tidak benar. Jalankan utilitas Computer Setup lalu ganti urutan boot dalam
Storage > Boot Order.

Media Boot Lepas dinonaktifkan dalam utilitas Computer
Setup.

Jalankan utilitas Computer Setup, kemudian aktifkan 'booting
to removable media' dalam Storage > Storage Options.
Pastikan USB diaktifkan dalam Storage > Boot Order.

Image pada perangkat tidak dapat di-boot. Ikuti prosedur yang dijelaskan dalam bagian "ROM Flash:
Membuat Replika Konfigurasi Pengaturan: Membuat
Perangkat Boot: Perangkat Media USB Flash" pada Panduan
Referensi Servis.

Komputer mem-boot dengan DOS setelah membuat Drive Key boot.

Penyebab Solusi

Drive Key dapat di-boot. Instal Drive Key hanya setelah sistem operasi di-boot.
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Mengatasi Masalah Komponen Panel Depan
Jika Anda mengalami masalah pada perangkat yang dihubungkan ke panel depan, lihat penyebab yang
umum beserta solusinya dalam tabel berikut ini.

Tabel 2-17  Mengatasi Masalah Komponen Panel Depan

Perangkat USB, hadphone, atau mikrofon tidak dikenal oleh komputer.

Penyebab Solusi

Perangkat tidak terhubung dengan benar. 1. Matikan komputer.

2. Hubungkan ulang perangkat ke bagian depan komputer
kemudian hidupkan ulang komputer.

Perangkat tidak mendapat cukup daya listrik. Jika perangkat USB memerlukan daya AC, pastikan salah satu
sambungan terhubung ke perangkat dan satunya lagi ke stop
kontak.

Driver perangkat yang diperlukan belum diinstal. 1. Instal driver printer yang sesuai untuk perangkat tersebut.

2. Anda mungkin perlu mem-boot ulang komputer.

Kabel dari perangkat ke komputer tidak berfungsi. 1. Jika perlu, ganti kabel tersebut.

2. Hidupkan ulang komputer.

Perangkat tidak bekerja. 1. Ganti perangkat tersebut.

2. Hidupkan ulang komputer.

Port USB pada komputer dinonaktifkan pada Computer Setup. Buka Computer Setup (F10) lalu aktifkan port USB.
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Mengatasi Masalah Akses Internet
Jika Anda mengalami masalah akses Internet, hubungi penyedia layanan Internet (Internet Service
Provider atau ISP) atau lihat daftar penyebab umum beserta solusinya dalam tabel berikut ini.

Tabel 2-18  Mengatasi Masalah Akses Internet

Tidak dapat terhubung ke Internet.

Penyebab Solusi

Account Penyedia Layanan Internet (ISP) tidak diatur dengan
benar.

Periksa pengaturan Internet atau hubungi ISP Anda untuk
bantuan.

Modem tidak diatur dengan benar. Ulangi sambungan ke modem. Periksa sambungan sesuai
dokumentasi pengaturan cepat (quick setup).

Browser Web tidak diatur dengan benar. Pastikan browser Web sudah terinstal dan diatur agar
berfungsi dengan ISP Anda.

Modem kabel/DSL belum terpasang. Hubungkan modem kabel/DSL. LED "daya" yang ada di
bagian depan modem kabel/DSL harus menyala.

Layanan kabel/DSL tidak tersedia atau terganggu akibat
cuaca buruk.

Coba beberapa saat lagi atau hubungi ISP Anda. (Jika layanan
kabel/DSL terhubung, lampu LED "kabel" pada bagian depan
modem kabel/DSl akan menyala.)

Kabel CAT5 UTP tidak terhubung. Hubungkan kabel UTP CAT5 antara modem kabel dan
konektor RJ-45 komputer. (Jika sambungannya bagus, lampu
LED "PC" pada bagian depan modem kabel/ DSL akan
menyala.)

Alamat IP tidak dikonfigurasikan dengan benar. Hubungi ISP untuk mengetahui alamat IP yang benar.

Cookie bermasalah (corrupted). ("Cookie" adalah sebagian
kecil informasi yang disimpan sementara oleh server Web
melalui browser Web. Gunanya adalah agar browser
mengambil informasi yang tersimpan untuk digunakan saat
terhubung kembali ke server Web tersebut.)

Windows Vista

1. Pilih Start [Mulai] > Control Panel [Panel Kontrol].

2. Klik Network and Internet.

3. Klik Internet Options.

4. Di bagian Browsing history pada tab General, klik
tombol Delete.

5. Klik tombol Delete cookies.

Windows XP

1. Pilih Start > Control Panel.

2. Klik dua kali Internet Options.

3. Pada tab General, klik tombol Delete Cookies.

Tidak dapat membuka program Internet secara otomatis.

Penyebab Solusi

Anda harus masuk ke ISP terlebih dahulu agar program dapat
dijalankan.

Masuk ke ISP Anda, kemudian buka program yang
dikehendaki.
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Internet terlalu lama dalam menampilkan situs Web.

Penyebab Solusi

Modem tidak diatur dengan benar. Periksa apakah modem sudah terhubung dan berkomunikasi
dengan benar.

Windows XP

1. Pilih Start > Control Panel.

2. Klik dua kali System.

3. Klik tab Hardware.

4. Pada area Device Manager, klik tombol Device
Manager.

5. Klik dua kali Modems.

6. Klik dua kali Agere Systems PCI-SV92PP Soft
Modem.

7. Pada tab General, klik Diagnostics.

8. Klik Query Modem. Respons "Success" menandakan
bahwa modem sudah terhubung dan berfungsi baik.

Windows Vista

1. Pilih Start > Control Panel.

2. Klik System and Maintenance.

3. Klik System.

4. Dalam daftar Tasks, pilih Device Manager.

5. Klik dua kali Modems.

6. Klik dua kali Agere Systems PCI-SV92PP Soft
Modem.

7. Pada tab General, klik Diagnostics.

8. Klik Query Modem. Respons "Success" menandakan
bahwa modem sudah terhubung dan berfungsi baik.

Tabel 2-18  Mengatasi Masalah Akses Internet (Lanjutan)
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Mengatasi Masalah Perangkat Lunak
Umumnya masalah perangkat lunak disebabkan oleh hal berikut:

● Aplikasi tidak diinstal atau dikonfigurasikan dengan benar.

● Memori yang tersedia tidak cukup untuk menjalankan aplikasi tersebut.

● Ada konflik antar aplikasi.

● Pastikan bahwa semua driver perangkat yang diperlukan, sudah diinstal.

● Jika Anda telah menginstal sistem operasi selain dari sistem operasi yang diinstal pabrik, periksa
dan pastikan bahwa sistem operasi tersebut didukung oleh sistem komputer.

Jika Anda mengalami masalah perangkat lunak, lihat daftar solusi yang sesuai dalam tabel berikut.

Tabel 2-19  Mengatasi Masalah Perangkat Lunak

Komputer berhenti beroperasi, dan tidak ada layar logo HP yang muncul.

Penyebab Solusi

Terjadi kesalahan POST. Perhatikan bunyi bip dan LED yang menyala di bagian depan
komputer. Lihat Lampiran A, Pesan Kesalahan POST
pada hal. 50 untuk menentukan kemungkinan penyebabnya.

Lihat Restore Kit atau Jaminan Terbatas di Seluruh Dunia
untuk mengetahui persyaratan dan ketentuan yang terkait.

Komputer berhenti beroperasi setelah layar logo HP muncul.

Penyebab Solusi

File sistem mungkin rusak. Gunakan disket pemulihan untuk menemukan kesalahan pada
hard drive.

Pesan kesalahan "Illegal Operation has Occurred" ditampilkan.

Penyebab Solusi

Perangkat lunak yang digunakan tidak bersertifikasi Microsoft
untuk digunakan pada versi Windows tersebut.

Pastikan bahwa perangkat lunak tersebut bersertifikasi
Microsoft untuk digunakan pada versi Windows Anda (lihat
kemasan program untuk mengetahui informasi ini).

File konfigurasi rusak. Jika mungkin, simpan semua data, tutup semua program, lalu
hidupkan ulang komputer.
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Menghubungi Dukungan Pelanggan
Untuk mendapatkan bantuan dan layanan, hubungi agen atau penyalur resmi. Untuk mencari agen atau
penyalur di tempat Anda, kunjungi http://www.hp.com.

CATATAN: Jika Anda membawa komputer ini untuk diservis ke agen, penyalur, atau penyedia
layanan resmi, ingatlah untuk memberikan sandi pengaturan (setup) dan sandi penyalaan komputer
(power-on), jika ada.

Lihat nomor telepon yang tercantum dalam jaminan atau dalam panduan Nomor Telepon Dukungan
untuk bantuan teknis.
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A Pesan Kesalahan POST

Lampiran ini berisi kode kesalahan, pesan kesalahan, serta berbagai lampu indikator dan kode suara
yang mungkin Anda temui selama Power-On Self-Test (POST) atau ketika menghidupkan ulang
komputer, kemungkinan sumber masalah, serta langkah-langkah yang dapat diambil untuk mengatasi
kondisi kesalahan tersebut.

POST Message Disabled akan menghilangkan sebagian besmx pesan sistem selama POST, seperti
hitungan memori dan pesan teks non-kesalahan. Jika terjadi kesalahan POST, layar akan menampilkan
pesan kesalahan tersebut. Untuk beralih secara manual ke mode POST Messages Enabled ketika
POST berlangsung, tekan salah satu tombol (kecuali F10 atau F12). Mode standar adalah POST
Message Disabled.

Kecepatan pemuatan sistem operasi oleh komputer serta sejauh mana pengujian akan dilakukan
ditentukan oleh pemilihan mode POST.

Quick Boot adalah proses mulai (startup) cepat yang tidak menjalankan semua pengujian level sistem,
seperti uji memori. Dalam Full Boot (boot lengkap), semua pengujian sistem berbasis-ROM akan
dijalankan, sehingga memerlukan lebih banyak waktu.

Full Boot juga dapat diaktifkan agar dijalankan setiap 1 hingga 30 hari secara berkala. Untuk
menetapkan jadwal boot, rekonfigurasikan komputer ke mode Full Boot Every x Days, dengan
menggunakan Computer Setup.

CATATAN: Untuk informasi lebih lanjut mengenai Computer Setup, lihat Panduan Utilitas Pengaturan
Komputer (F10).
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Kode Numerik dan Pesan Teks POST
Bagian ini mencakup kesalahan POST yang memiliki kode numerik. Bagian ini juga berisi sejumlah
pesan teks yang mungkin muncul sewaktu POST berlangsung.

CATATAN: Komputer akan berbunyi bip satu kali setelah pesan teks POST ditampilkan di layar.

Tabel A-1  Kode Numerik dan Pesan Teks

Pesan panel kontrol Keterangan Tindakan yang dianjurkan

101-Option ROM Checksum Error Checksum (jumlah perhitungan data) ROM
sistem atau ROM perangkat tambahan
papan ekspansi.

1. Periksa kebenaran ROM.

2. Lakukan flash (penulisan) ROM jika
diperlukan.

3. Jika ada papan ekspansi yang baru
ditambahkan, lepaskanlah untuk
melihat apakah masalahnya tetap ada.

4. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

5. Jika pesan ini hilang, mungkin ada
masalah dengan kartu ekspansi
tersebut.

6. Gantilah system board.

103-System Board Failure DMA atau timer (pengatur waktu). 1. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

2. Lepaskan papan ekspansi.

3. Gantilah system board.

110-Out of Memory Space for Option ROMs Kartu ekspansi PCI yang baru dipasang
berisi ROM perangkat tambahan yang terlalu
besmx untuk di-download dalam POST.

1. Jika ada kartu ekspansi PCI yang baru
ditambahkan, lepaskanlah untuk
melihat apakah masalahnya tetap ada.

2. Pada Computer Setup, setel
Advanced > Device Options > NIC
PXE Option ROM Download ke
DISABLE agar ROM perangkat
tambahan PXE untuk NIC internal tidak
di-download ketika POST berlangsung,
sehingga diperoleh lebih banyak
memori untuk ROM perangkat
tambahan kartu ekspansi. ROM
tambahan PXE internal digunakan
untuk mem-boot dari NIC ke server
PXE.

3. Pastikan pengaturan ACPI/USB Buffers
@ Top of Memory pada Computer
Setup diaktifkan.

162-System Options Not Set Konfigurasi tidak sesuai.

Baterai RTC (real-time clock) mungkin perlu
diganti.

Jalankan Computer Setup, kemudian periksa
konfigurasi pada Advanced > Onboard
Devices.

Setel ulang tanggal dan waktu pada Control
Panel. Jika masalah tetap berlanjut, ganti
baterai RTC. Lihat Panduan Referensi
Perangkat Keras untuk petunjuk cara
memasang baterai baru, atau hubungi
penyalur atau penjual resmi untuk minta
bantuan mengganti baterai RTC.
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

163-Time & Date Not Set Waktu dan tanggal tidak valid dalam memori
konfigurasi.

Baterai RTC (real-time clock) mungkin perlu
diganti.

Setel ulang tanggal dan waktu pada Control
Panel (Computer Setup juga dapat
digunakan untuk ini). Jika masalah tetap
berlanjut, ganti baterai RTC. Lihat Panduan
Referensi Perangkat Keras untuk petunjuk
cara memasang baterai baru, atau hubungi
penyalur atau penjual resmi untuk minta
bantuan mengganti baterai RTC.

163-Time & Date Not Set Jumper CMOS mungkin tidak terpasang
dengan benar.

Periksa apakah jumper CMOS terletak
dengan benar, jika ada.

164-MemorySize Error Jumlah memori telah berubah sejak boot
terakhir (ada memori yang ditambahkan atau
dilepaskan).

Tekan tombol F1 untuk menyimpan
perubahan memori.

164-MemorySize Error Konfigurasi memori tidak sesuai. 1. Jalankan Computer Setup atau utilitas
Windows.

2. Pastikan modul-modul memori
terpasang dengan benar.

3. Jika ada memori pihak-ketiga yang
ditambahkan, lakukan pengujian
dengan menggunakan hanya memori
HP.

4. Periksa apakah jenis modul memori
sudah sesuai.

201-Memory Error Kegagalan RAM. 1. Jalankan Computer Setup atau utilitas
Windows.

2. Pastikan modul memori terpasang
dengan benar.

3. Periksa apakah jenis modul memori
sudah sesuai.

4. Lepaskan dan ganti modul memori yang
diduga bermasalah.

5. Jika kesalahan terus berlanjut setelah
modul memori diganti, gantilah papan
sistem.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

Modul memori dalam soket memori yang
disebutkan dalam pesan kesalahan tersebut
tidak memiliki informasi SPD yang
diperlukan, atau tidak kompatibel dengan
chipset-nya.

1. Periksa apakah jenis modul memori
sudah sesuai.

2. Cobalah soket memori yang lain.

3. Gantilah DIMM dengan modul yang
memenuhi standar SPD.

214-DIMM Configuration Warning Konfigurasi DIMM yang dipasang tidak
dioptimalisasikan.

Atur ulang DIMM sehingga setiap kanal
memiliki jumlah memori yang sama.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Modul memori yang baru ditambahkan
mendukung koreksi kesalahan memori ECC.

1. Jika ada memori yang baru
ditambahkan, lepaskanlah untuk
melihat apakah masalahnya tetap ada.

2. Lihat dokumentasi produk untuk
mengetahui informasi mengenai
dukungan memori.

301-Keyboard Error Keyboard tidak berfungsi. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Periksa konektor, apakah ada pin yang
tertekuk atau hilang.

Tabel A-1  Kode Numerik dan Pesan Teks (Lanjutan)
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

3. Pastikan bahwa tidak ada tombol yang
tertekan.

4. Ganti keyboard.

303-Keyboard Controller Error Kontroler keyboard pada papan I/O. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Gantilah system board.

304-Keyboard or System Unit Error Keyboard tidak berfungsi. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Pastikan bahwa tidak ada tombol yang
tertekan.

3. Ganti keyboard.

4. Gantilah system board.

404-Parallel Port Address Conflict Detected Port eksternal dan internal keduanya
ditetapkan ke port paralel X.

1. Lepaskan semua kartu ekspansi port
paralel.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup.

410-Audio Interrupt Conflict Alamat IRQ mengalami konflik dengan
perangkat lainnya.

Buka Computer Setup lalu setel ulang IRQ
dalam Advanced > Onboard Devices.

411-Network Interface Card Interrupt Conflict Alamat IRQ mengalami konflik dengan
perangkat lainnya.

Buka Computer Setup lalu setel ulang IRQ
dalam Advanced > Onboard Devices.

501-Display Adapter Failure Kontroler display gambar. 1. Ulangi pemasangan kartu gambar (jika
ada).

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

3. Pastikan bahwa monitor sudah
terpasang dan dihidupkan.

4. Ganti kartu gambar (jika mungkin).

510-Flash Screen Image Corrupted Ada kesalahan gambar Layar Flash. Flash ulang sistem ROM dengan image BIOS
terbaru.

511-CPU, CPUA, or CPUB Fan not Detected Kipas CPU tidak terhubung atau
kemungkinan rusak.

1. Ulangi pemasangan kipas CPU.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas CPU.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Kipas rangka, rangka belakang, atau rangka
depan tidak terhubung atau kemungkinan
rusak.

1. Ulangi pemasangan kipas rangka,
rangka belakang, atau rangka depan.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas rangka, rangka belakang,
atau rangka depan.

514-CPU or Chassis Fan not Detected Kipas CPU atau kipas rangka tidak terhubung
atau kemungkinan rusak.

1. Ulangi pemasangan kipas CPU atau
kipas rangka.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas CPU atau kipas rangka.
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

601-Diskette Controller Error Sirkuit kontroler disket atau sirkuit drive
disket tidak sesuai.

1. Jalankan Computer Setup.

2. Periksa dan/atau ganti kabel-kabelnya.

3. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

4. Ganti drive disket.

5. Gantilah system board.

605-Diskette Drive Type Error Jenis drive tidak sesuai. 1. Jalankan Computer Setup.

2. Lepaskan perangkat kontroler disket
lainnya (drive tape).

3. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

610-External Storage Device Failure Drive tape eksternal tidak terhubung. Pasang kembali drive tape atau tekan F1 dan
biarkan sistem melakukan konfigurasi ulang
tanpa drive tersebut.

611-Primary Floppy Port Address
Assignment Conflict

Kesalahan konfigurasi. Jalankan Computer Setup, kemudian periksa
konfigurasi pada Advanced > Onboard
Devices.

660-Display cache is detected unreliable Cache (memori sementara) display kontroler
gambar terpadu tidak berfungsi dengan
benar sehingga akan dinonaktifkan.

Ganti system board jika menimbulkan
masalah penurunan kualitas gambar.

912-Computer Cover Has Been Removed
Since Last System Startup

Penutup komputer dilepaskan sejak startup
sistem terakhir.

Tidak perlu tindakan apa-apa.

917-Front Audio Not Connected Rangkaian kabel audio depan tidak
dihubungkan atau terlepas dari papan induk.

Hubungkan kembali atau ganti jaringan kabel
audio depan.

918-Front USB Not Connected Kabel USB depan tidak dihubungkan atau
terlepas dari papan induk.

Hubungkan kembali atau ganti kabel USB
depan.

921-Device in PCI Express slot failed to
initialize

Terdapat ketidaksesuaian/masalah pada
perangkat dan sistem atau PCI Express Link
tidak dapat ditahan pada x1.

Coba boot ulang sistem. Jika kesalahan
terjadi lagi, perangkat tersebut tidak dapat
bekerja pada sistem

1151-Serial Port A Address Conflict Detected Port serial eksternal dan internal keduanya
dipasang pada COM1.

1. Lepaskan semua kartu ekspansi port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.

1152-Serial Port B Address Conflict Detected Port serial eksternal dan internal keduanya
dipasang pada COM2.

1. Lepaskan semua kartu ekspansi port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.

Tabel A-1  Kode Numerik dan Pesan Teks (Lanjutan)
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1155-Serial Port Address Conflict Detected Port serial eksternal dan internal keduanya
dipasang pada IRQ yang sama.

1. Lepaskan semua kartu ekspansi port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Menyetel Ulang
CMOS pada hal. 62.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.

1201-System Audio Address Conflict
Detected

Alamat IRQ perangkat mengalami konflik
dengan perangkat lainnya.

Buka Computer Setup lalu setel ulang IRQ
dalam Advanced > Onboard Devices.

1202-MIDI Port Address Conflict Detected Alamat IRQ perangkat mengalami konflik
dengan perangkat lainnya.

Buka Computer Setup lalu setel ulang IRQ
dalam Advanced > Onboard Devices.

1203-Game Port Address Conflict Detected Alamat IRQ perangkat mengalami konflik
dengan perangkat lainnya.

Buka Computer Setup lalu setel ulang IRQ
dalam Advanced > Onboard Devices.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive akan gagal berfungsi. (Hard drive
tertentu memiliki tambalan (patch) firmware
hard drive yang dapat memperbaiki
kekeliruan pesan kesalahan.)

1. Perhatikan apakah hard drive
memberikan pesan kesalahan yang
benar. Buka Computer Setup,
kemudian jalankan uji Drive Protection
System pada Storage > DPS Self-test.

2. Gunakan tambalan (patch) firmware
hard drive, jika ada. (Dapat diperoleh di
http://www.hp.com/support.)

3. Buat cadangan isi hard drive, kemudian
ganti hard drive.

1796-SATA Cabling Error Terdapat satu atau beberapa perangkat
SATA yang tidak terpasang dengan benar.
Untuk kinerja optimal, konektor SATA0 dan
SATA1 harus digunakan dulu sebelum
SATA2 dan SATA3.

Pastikan konektor SATA digunakan dalam
urutan dari bawah ke atas. Untuk satu
perangkat, gunakan SATA0. Untuk dua
perangkat, gunakan SATA0 dan SATA1.
Untuk tiga perangkat, gunakan SATA0,
SATA1, dan SATA2.

1797-SATA Drivelock tidak didukung dalam
mode RAID.

Drivelock diaktifkan pada satu atau beberapa
hard drive SATA, dan tidak dapat diakses bila
sistem dikonfigurasikan untuk mode RAID.

Lepaskan perangkat SATA yang terkunci
Drivelock atau nonaktifkan fitur Drivelock.
Untuk menonaktifkan fitur Drivelock, buka
Computer Setup, ubah Storage > Storage
Options > SATA Emulation menjadi IDE,
lalu pilih File > Save Changes and Exit.
Buka kembali Computer Setup lalu Security
> Drivelock. Untuk setiap perangkat SATA
dengan kemampuan Drivelock yang
terdaftar, pastikan Drivelock Disabled.
Terakhir, ubah Storage > Storage Options
> SATA Emulation kembali ke RAID lalu
pilih File > Save Changes and Exit.

1801-Microcode Patch Error Prosesor tidak didukung oleh BIOS ROM. 1. Tingkatkan BIOS ke versi yang sesuai.

2. Ganti prosesor.

2200-PMM Allocation Error during MEBx
Download

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Cabut kabel daya, atur ulang dudukan
modul memori, lalu hidupkan ulang
komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan komputer, pulihkan
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konfigurasi memori asli, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, gantilah
system board.

2201-MEBx Module did not checksum
correctly

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Cabut kabel daya, atur ulang dudukan
modul memori, lalu hidupkan ulang
komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi memori asli, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, gantilah
system board.

2202-PMM Deallocation Error during MEBx
cleanup

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Cabut kabel daya, atur ulang dudukan
modul memori, lalu hidupkan ulang
komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi memori asli, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, gantilah
system board.

2203-Setup error during MEBx execution Pemilihan atau keluar dari MEBx
mengakibatkan kegagalan pengaturan.

1. Hidupkan ulang komputer.

2. Cabut kabel daya, atur ulang dudukan
modul memori, lalu hidupkan ulang
komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi memori asli, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, gantilah
system board.

2204-Inventory error during MEBx execution Informasi BIOS yang diteruskan ke MEBx
mengakibatkan kegagalan.

1. Hidupkan ulang komputer.

2. Jika kesalahan terus berlanjut, perbarui
dengan versi BIOS terbaru.

3. Jika kesalahan terus berlanjut, gantilah
system board.

2205-Interface error during MEBx execution Operasi MEBx mengalami kesalahan
perangkat keras saat berkomunikasi dengan
ME.

1. Hidupkan ulang komputer.

2. Jika kesalahan terus berlanjut, perbarui
dengan versi BIOS terbaru.

3. Jika kesalahan terus berlanjut, gantilah
system board.

Konfigurasi memori tidak diatur dengan
benar.

DIMMI tidak diinstal. Pastikan ada modul memori dalam soket
DIMM1 hitam dan terpasang dengan benar.

Invalid Electronic Serial Number Nomor seri elektronik tidak ada. Masukkan nomor seri yang benar dalam
Computer Setup.
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Network Server Mode Active and No
Keyboard Attached

Keyboard tidak berfungsi saat Network
Server Mode diaktifkan.

1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Periksa konektor, apakah ada pin yang
tertekuk atau hilang.

3. Pastikan bahwa tidak ada tombol yang
tertekan.

4. Ganti keyboard.

Parity Check 2 Kegagalan Parity RAM. Jalankan Computer Setup dan utilitas
Diagnostik.

System will not boot without fan Kipas CPU tidak terpasang atau terlepas
pada rangka VSFF.

1. Buka penutup komputer, tekan tombol
daya, dan lihat apakah kipas prosesor
berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas
terhubung ke kepala system board.
Pastikan heatsink bertumpu atau
terpasang sepenuhnya.

2. Jika kipas sudah terpasang dan
heatsink bertumpu dengan baik, namun
kipas tidak berputar, gantilah unit kipas-
heatsink tersebut.
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Menafsirkan Kode-kode Lampu LED Panel Depan dan
Suara Diagnostik POST

Bagian ini mencakup soal kode lampu LED panel depan serta kode suara yang terdengar, yang mungkin
terjadi sebelum atau sewaktu POST dan tidak selalu disertai kode kesalahan atau pesan teks terkait.

PERINGATAN! Bila komputer dihubungkan ke stopkontak listrik AC, selalu ada tegangan pada
system board. Untuk mengurangi risiko cedera dari sengatan listrik dan/atau permukaan panas,
pastikan untuk melepaskan kabel daya dari dtopkontak di dinding dan biarkan komponen sistem internal
mendingin sebelum menyentuhnya.

CATATAN: Jika Anda melihat LED berkedip pada papan ketik PS/2, lihat apakah ada LED yang
berkedip pada panel depan komputer, lalu lihat tabel berikut untuk menentukan kode LED panel
depan.

Tindakan yang disarankan pada tabel berikut dicantumkan sesuai dengan urutan pelaksanaannya.

Tidak semua kode lampu dan suara diagnostik tersedia pada semua model.

Tabel A-2  Kode-kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik

Aktivitas Bunyi Bip Kemungkinan Penyebab Tindakan yang Disarankan

LED Daya menyala Hijau. None
(Tidak ada)

Komputer dalam keadaan
hidup.

None (Tidak ada)

Lampu LED Daya Hijau
berkedip setiap dua detik.

None
(Tidak ada)

Komputer berada dalam
mode Suspend to RAM
(hanya model tertentu)
atau mode Suspend
normal.

Tidak diperlukan tindakan apa-apa. Tekan salah
satu tombol untuk menggerakkan mouse untuk
membangunkan komputer.

LED daya berkedip Merah dua
kali, setiap detik sekali, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan namun LED
terus menyala sampai
masalah teratasi.

2 Perlindungan panas
prosesor diaktifkan:

Ada kipas yang mungkin
terhalang atau tidak
berputar.

ATAU

Unit pendingin (heatsink)
tidak terhubung dengan
baik pada prosesor.

1. Pastikan ventilasi udara komputer tidak
terhalang dan kipas pendingin prosesor
berfungsi baik.

2. Buka penutup atas, tekan tombol daya, dan
lihat apakah kipas prosesor berputar. Jika
kipas prosesor tidak berputar, pastikan kabel
kipas terhubung ke kepala system board.

3. Jika kipas sudah terpasang, tetapi tidak
berputar, ganti rakitan heatsink/kipas.

4. Hubungi agen atau penyedia layanan resmi.

LED daya berkedip Merah tiga
kali, setiap detik sekali, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan namun LED
terus menyala sampai
masalah teratasi.

3 Prosesor tidak terpasang
(bukan merupakan
indikator prosesor rusak).

1. Periksa apakah prosesor ada.

2. Ulangi pemasangan prosesor.
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LED daya berkedip Merah
empat kali, setiap detik sekali,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan namun LED
terus menyala sampai
masalah teratasi.

4 Gangguan daya (catu
daya kelebihan beban).

ATAU

Adaptor catu daya
eksternal yang salah
ternyata digunakan pada
USDT.

1. Buka penutup atas dan pastikan kabel catu
daya 4atau 6-kawat sudah terpasang pada
konektor di papan sistem.

2. Periksa apakah ada perangkat yang
menyebabkan masalah tersebut, yakni
dengan melepaskan SEMUA perangkat
yang terpasang (seperti hard drive, drive
disket, atau drive optik, serta kartu ekspansi).
Hidupkan sistem. Jika sistem memasuki
POST, maka matikan komputer dan pasang
kembali perangkat satu per satu, kemudian
ulangi prosedur di atas sampai gangguan
muncul. Ganti perangkat yang
menyebabkan gangguan tersebut.
Lanjutkan dengan memasang perangkat
satu per satu untuk memastikan semua
perangkat berfungsi dengan benar.

3. Ganti catu daya.

4. Gantilah system board.

ATAU

Adaptor catu daya USDT harus 135W dan
menggunakan teknologi ID Smart sebelum sistem
akan dialiri daya. Gantilah adaptor catu daya
dengan adaptor catu daya USDT yang disediakan
oleh HP.

LED daya berkedip Merah lima
kali, setiap detik sekali, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan namun LED
terus menyala sampai
masalah teratasi.

5 Kesalahan memori pra-
video

PERHATIAN: Untuk menghindari kerusakan
pada DIMM atau system board, Anda harus
melepaskan kabel daya komputer sebelum
mencoba mengatur ulang dudukan, menginstal,
atau melepaskan modul DIMM.

1. Ulangi pemasangan DIMM.

2. Ganti DIMM satu per satu untuk memisahkan
modul yang bermasalah.

3. Ganti memori pihak ketiga dengan memori
HP.

4. Gantilah system board.

LED daya berkedip Merah
enam kali, setiap detik sekali,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan namun LED
terus menyala sampai
masalah teratasi.

6 Kesalahan gambar pra-
video

Untuk sistem yang dilengkapi kartu gambar:

1. Ulangi pemasangan kartu gambar.

2. Ganti kartu gambar.

3. Gantilah system board.

Untuk sistem dengan gambar terpadu, ganti
system board.

LED daya berkedip Merah
tujuh kali, setiap detik sekali,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan namun LED
terus menyala sampai
masalah teratasi.

7 Gangguan system board
(masalah ROM yang
terdeteksi sebelum masuk
ke video)

Gantilah system board.

LED daya berkedip Merah
delapan kali, setiap detik
sekali, diikuti dengan jeda dua

8 ROM tidak valid akibat
checksum yang buruk.

1. Flash ulang sistem ROM dengan image
BIOS terbaru. Untuk informasi lebih lanjut,
lihat bagian "Boot Block Emergency
Recovery Mode" dalam Panduan
Manajemen Desktop.

2. Gantilah system board.
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detik. Bunyi bip berhenti
setelah lima kali pengulangan
namun LED terus menyala
sampai masalah teratasi.

LED daya berkedip Merah
sembilan kali, setiap detik
sekali, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan
namun LED terus menyala
sampai masalah teratasi.

9 Sistem dapat dihidupkan,
tapi tidak dapat mem-boot.

1. Periksa apakah switch pengatur tegangan,
yang terletak di bagian belakang catu daya
(model tertentu), sudah diatur ke tegangan
yang benar. Setelan tegangan yang benar
tergantung pada negara/kawasan Anda.

2. Cabut kabel listrik AC dari komputer, tunggu
30 detik lalu colokkan kembali kabel listrik ke
komputer.

3. Gantilah system board.

4. Ganti prosesor.

LED daya berkedip Merah
sepuluh kali, setiap detik
sekali, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan
namun LED terus menyala
sampai masalah teratasi.

10 Kartu tambahan rusak. 1. Periksa kartu tambahan dengan melepaskan
setiap kartu (satu per satu jika dipasang
banyak kartu), kemudian hidupkan sistem
untuk melihat apakah masalah teratasi.

2. Setelah kartu yang rusak ditemukan,
lepaskan lalu ganti kartu tambahan yang
rusak tersebut.

3. Gantilah system board.

LED Daya berkedip Merah
sebelas kali, setiap detik
sekali, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan
namun LED terus menyala
sampai masalah teratasi.

11 Prosesor yang sekarang
tidak mendukung fitur
yang sebelumnya
difungsikan pada sistem
ini.

1. Menginstal prosesor berkemampuan TXT.

2. Melumpuhkan TXT dalam utilitas Computer
Setup (F10).

3. Menginstal ulang prosesor asli.

Sistem tidak dapat dihidupkan
dan LED tidak berkedip.

None
(Tidak ada)

Sistem tidak dapat
dihidupkan.

Tekan terus tombol daya selama kurang dari 4
detik. Jika LED hard drive menyala hijau, tombol
daya berfungsi normal. Cobalah berikut ini:

1. Periksa apakah saklar pengatur tegangan
(pada sebagian model), yang terletak di
bagian belakang catu daya, sudah diset ke
tegangan yang benar. Setelan tegangan
yang benar tergantung pada negara/
kawasan Anda.

2. Gantilah system board.

ATAU

Tekan terus tombol daya selama kurang dari 4
detik. Jika LED hard drive tidak berubah hijau,
maka:

1. Periksa apakah unit komputer dihubungkan
ke stopkontak AC yang berfungsi baik.

2. Buka penutup atas dan periksa apakah
kabel-kabel tombol daya sudah terpasang
dengan benar ke system board.

3. Periksa apakah kedua kabel catu daya
terhubung dengan benar ke system board.

4. Periksa apakah lampu 5V_aux pada system
board menyala. Jika menyala, maka gantilah

Tabel A-2  Kode-kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik (Lanjutan)
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rangkaian kabel tombol daya. Jika masalah
tetap ada, gantilah system board.

5. Jika lampu 5V_aux pada system board tidak
menyala, lepaskan kartu tambahan satu per
satu sampai lampu 5V_aux pada system
board menyala. Jika tetap bermasalah,
gantilah unit catu daya.
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B Keamanan Sandi dan Menyetel Ulang
CMOS

Komputer ini dilengkapi fitur sandi pengaman , yang dapat ditetapkan melalui menu Computer Setup
Utilities.

Komputer ini mendukung dua fitur sandi pengaman, yang dapat ditetapkan melalui menu Utilitas
Computer Setup: sandi pengaturan dan sandi penyalaan. Jika Anda hanya menggunakan sandi
pengaturan, setiap pengguna dapat mengakses semua informasi pada komputer ini, kecuali Computer
Setup. Jika Anda hanya menggunakan sandi penyalaan, sandi ini diperlukan untuk mengakses
Computer Setup serta informasi lain pada komputer. Jika Anda menggunakan kedua sandi, maka hanya
sandi pengaturan yang dapat memberi akses ke Computer Setup.

Jika kedua sandi digunakan, sandi pengaturan juga dapat digunakan untuk menggantikan sandi
penyalaan sebagai pengganti (override) untuk mengakses komputer. Ini adalah fitur yang sangat
berguna bagi administrator jaringan.

Jika Anda lupa sandi untuk komputer, Anda dapat mengosongkan sandi tersebut dengan menyetel
ulang jumper sandi, sehingga Anda dapat mengakses informasi pada komputer.

PERHATIAN: Menekan tombol CMOS akan menyetel ulang nilai CMOS ke pengaturan default pabrik.
Jangan lupa untuk membuat salinan cadangan pengaturan CMOS komputer sebelum menyetel ulang,
sebagai tindakan berjaga-jaga jika dibutuhkan di lain waktu. Pembuatan cadangan dapat dengan
mudah dilakukan melalui Computer Setup. Lihat Panduan Utilitas Pengaturan Komputer (F10) untuk
informasi mengenai membuat cadangan pengaturan CMOS.
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Menyetel ulang Password Jumper
Untuk menonaktifkan fitur sandi penyalaan atau sandi pengaturan, atau untuk menghapus sandi
penyalaan atau sandi pengaturan, ikuti langkah-langkah berikut:

1. Matikan (shut down) sistem operasi dengan benar, kemudian matikan komputer dan semua
perangkat eksternal, lalu cabut kabel daya dari stopkontak.

2. Setelah kabel daya dicabut, tekan kembali tombol daya untuk menghilangkan sisa muatan listrik
dari sistem.

PERINGATAN! Untuk mengurangi risiko cedera pribadi akibat sengatan listrik dan/atau
permukaan yang panas, pastikan untuk melepaskan kabel daya dari stopkontak di dinding dan
untuk membiarkan komponen sistem sampai dingin sebelum menyentuhnya.

PERHATIAN: Jika komputer terhubung ke sumber listrik, catu daya selalu menyalurkan
tegangan ke papan sistem, walaupun komputer dalam keadaan dimatikan. Jika kabel daya tidak
dicabut, dapat terjadi kerusakan pada sistem.

Listrik statis dapat merusak komponen elektronik komputer atau peralatan tambahan. Sebelum
memulai prosedur ini, pastikan Anda telah melepaskan muatan listrik statik dengan menyentuh
sekilas benda logam yang diarde. Untuk informasi lebih lanjut, lihat panduan Informasi
Keselamatan & Pengaturan.

3. Lepaskan penutup komputer atau panel akses komputer.

4. Cari lokasi header dan jumper.

CATATAN: Jumper sandi berwarna hijau sehingga mudah dikenali. Untuk bantuan mencari
jumper sandi serta komponen papan sistem lainnya, lihat Illustrated Parts Map (IPM) untuk sistem
tersebut. IPM dapat di-download dari http://www.hp.com/support.

5. Lepaskan jumper dari pin 1 dan 2. Letakkan jumper pada salah satu dari pin 1 atau 2, tapi jangan
pada keduanya, sehingga jumper tidak hilang.

6. Replace the computer cover or access panel.

7. Sambungkan kembali perangkat eksternal.

8. Sambungkan komputer ke sumber listrik, kemudian hidupkan. Biarkan sistem operasi mulai
berjalan. Hal ini akan menghapus sandi serta menonaktifkan fitur sandi.

9. Untuk menetapkan sandi baru, ulangi langkah 1 sampai 4, ganti jumper sandi pada pin 1 dan 2,
kemudian ulangi langkah 6 sampai 8. Buat sandi baru pada Computer Setup. Lihat petunjuk
Computer Setup [Pengaturan Komputer] dalam Panduan Utilitas Pengaturan Komputer (F10).
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Menghapus dan Menyetel Ulang CMOS
Memori konfigurasi komputer (CMOS) menyimpan informasi tentang konfigurasi komputer.

Tombol CMOS menyetel ulang CMOS tetapi tidak menghapus sandi penyalaan dan pengaturan.

Mengosongkan CMOS akan menghapus pengaturan Active Management Technology (AMT) dalam
Management Engine BIOS Extension (MEBx), termasuk sandinya. Sandi akan di-default ke "admin"
dan harus disetel ulang. Pengaturan AMT juga harus disetel ulang. Untuk mengakses MEBx, tekan
CTRL+P sewaktu POST.

1. Matikan komputer dan semua perangkat eksternal, lalu lepaskan kabel daya dari stopkontak.

2. Putuskan sambungan keyboard, monitor, serta semua perangkat eksternal lain yang terhubung
ke komputer.

PERINGATAN! Untuk mengurangi risiko cedera pribadi akibat sengatan listrik dan/atau
permukaan yang panas, pastikan untuk melepaskan kabel daya dari stopkontak di dinding dan
untuk membiarkan komponen sistem sampai dingin sebelum menyentuhnya.

PERHATIAN: Jika komputer terhubung ke sumber listrik, catu daya selalu menyalurkan
tegangan ke papan sistem, walaupun komputer dalam keadaan dimatikan. Jika kabel daya tidak
dicabut, dapat terjadi kerusakan pada sistem.

Listrik statis dapat merusak komponen elektronik komputer atau peralatan tambahan. Sebelum
memulai prosedur ini, pastikan Anda telah melepaskan muatan listrik statik dengan menyentuh
sekilas benda logam yang diarde. Untuk informasi lebih lanjut, lihat panduan Informasi
Keselamatan & Pengaturan.

3. Lepaskan penutup komputer atau panel akses komputer.

PERHATIAN: Menekan tombol CMOS akan menyetel ulang nilai CMOS ke pengaturan default
pabrik. Jangan lupa untuk membuat salinan cadangan pengaturan CMOS komputer sebelum
menyetel ulang, sebagai tindakan berjaga-jaga jika dibutuhkan di lain waktu. Pembuatan cadangan
dapat dengan mudah dilakukan melalui Computer Setup. Lihat Panduan Utilitas Pengaturan
Komputer (F10) untuk informasi mengenai cara membuat cadangan pengaturan CMOS.
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4. Cari tombol CMOS, lalu tekan terus tombol ini selama lima detik.

CATATAN: Pastikan Anda sudah melepaskan kabel daya AC dari stopkontak di dinding. Tombol
CMOS tidak akan menghapus CMOS jika kabel daya masih terhubung ke stopkontak.

Gambar B-1  Tombol CMOS

CATATAN: Untuk bantuan mencari tombol CMOS serta komponen papan sistem lainnya, lihat
Illustrated Parts Map (IPM) untuk sistem tersebut.

5. Tutup kembali komputer atau panel akses.

6. Sambungkan kembali perangkat eksternal.

7. Sambungkan komputer ke sumber listrik, kemudian hidupkan.

CATATAN: Anda akan menerima pesan kesalahan POST setelah mengosongkan CMOS dan
melakukan boot ulang, yang memberitahukan adanya perubahan konfigurasi. Gunakan Computer
Setup untuk menyetel ulang semua pengaturan khusus sistem serta tanggal dan waktu.

Untuk petunjuk mengenai Computer Setup [Pengaturan Komputer], lihat Panduan Utilitas Pengaturan
Komputer (F10).
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C Drive Protection System (DPS)

Drive Protection System (DPS) adalah alat diagnostik terpadu pada hard disk yang terpasang pada
komputer tertentu. DPS dirancang untuk membantu mendiagnosis masalah yang mungkin
menyebabkan penggantian hard disk yang tidak perlu.

Ketika sistem ini dibuat, setiap hard drive yang terpasang diuji dengan menggunakan DPS, dan
informasi penting tertera pada drive tersebut. Setiap kali DPS dijalankan, hasil pengujian dicatat pada
hard drive. Penyedia layanan Anda dapat menggunakan informasi ini untuk membantu mendiagnosis
kondisi yang menyebabkan Anda menjalankan perangkat lunak DPS tersebut.

Jika DPS dijalankan, hal ini tidak akan mempengaruhi program atau data yang disimpan pada hard
drive. Pengujian ini berada dalam firmware hard drive dan dapat dijalankan walaupun komputer tidak
dapat di-boot ke sistem operasi. Waktu yang diperlukan untuk menjalankan pengujian ditentukan oleh
pabrikan serta tergantung ukuran hard drive; umumnya, pengujian ini memerlukan waktu sekitar dua
menit per gygabyte.

Gunakan DPS jika Anda menduga adanya masalah drive. Jika komputer mengeluarkan pesan SMART
Hard Drive Detect Imminent Failure, Anda tidak perlu menjalankan DPS; melainkan, buat cadangan
informasi pada hard drive tersebut, kemudian hubungi penyedia layanan untuk mendapatkan hard drive
pengganti.
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Mengakses DPS melalui Computer Setup
Bila penyalaan komputer tidak berlangsung dengan benar, Anda harus menggunakan Computer Setup
untuk mengakses program DPS. Untuk mengakses DPS, ikuti langkah-langkah berikut:

1. Hidupkan atau hidupkan ulang komputer.

2. Jika pesan F10 Setup muncul di sudut kanan bawah layar, tekan tombol F10.

CATATAN: Jika Anda tidak menekan tombol F10 ketika pesan tersebut ditampilkan, Anda harus
mematikan komputer, lalu menghidupkannya kembali, untuk mengakses utilitas tersebut.

Ada lima pilihan yang ditampilkan pada menu Computer Setup Utilities:File, Storage, Security,
Power, dan Advanced.

3. Pilih Storage > DPS Self-Test.

Layar akan menampilkan daftar hard drive berkemampuan DPS yang terpasang pada komputer.

CATATAN: Jika tidak ada hard drive yang dapat menjalankan DPS, pilihan DPS Self-Test tidak
akan muncul di layar.

4. Pilih hard drive yang akan diuji, kemudian ikuti perintah di layar untuk menyelesaikan proses
pengujian.

Setelah pengujian selesai, salah satu dari tiga pesan berikut akan ditampilkan:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

Jika pengujian gagal, kode akhir tersebut harus dicatat dan dilaporkan kepada penyedia layanan Anda
untuk mendapatkan bantuan dalam mendiagnosis masalah komputer.
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